
Support
 If you experience any problems with your software, please contact our support team: 
Support website: http://support.magix.net
 This website takes you to the MAGIX user service page; the following free offers are also featured
there: 

 FAQs (frequently asked questions) and general tricks and tips. In most cases, you'll find the
solution to your problem here. If not, use the email support form.

 Email support form: Use the special form to inform our support staff about your system. This
information is used to solve your problems quickly and competently. Simply fill it out and send it
with a mouse click!

 Support forum: You are not alone. Perhaps other users had a similar problem and can help you
solve yours. Our support staff are also regular contributors.

 Download section: Updates, improvements, and patches are likewise offered free of charge via
download. Many problems you may experience are already familiar to us, and they can often be
solved by downloading the latest patch. Besides patches, there are also wizards for checking and
optimizing your system.

 Links: The links list contains the contact addresses for all of the most important hardware
manufacturers.

Please note:
 To be able to use the support, you have to register your product using the serial number provided. This
number can be found on the CD case of your installation CD or on the inside of the DVD box. 

Europe
 Sales Department:
 Monday - Friday, 09:00-16:00 GMT 
U.K.: 
0203 3189218 
Denmark:
 699 18149 
Sweden: 
0852500858 
Finland: 
09 31581630 
Norway: 
0210 30665 
Support request via email: http://support.magix.net/contact/uk
 Here you can find a summary of our technical support telephone numbers: 
http://support.magix.net/phone/uk
 Mail:
 MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden, Germany 

North America
 Sales Department: 
9 am to 4 pm EST Mon-Fri 
Phone: 
1-305-722-5810 
Support request via email: http://support.magix.net/contact/us
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 Here you can find a summary of our technical support telephone numbers: 
http://support.magix.net/phone/us
 Mail: 
MAGIX Customer Service, 1105 Terminal Way #302, Reno, NV 89502, USA 
Please have the following information at hand:

  Program version
 Configuration details (operating system, processor, memory, hard drive, etc.), sound card

configuration (type, driver)
 Information regarding other audio software installed

In this chapter
MAGIX Sales
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MAGIX Sales
 You can reach MAGIX Sales Department workdays for help with the following questions and
problems: 

 Orders
 Product consulting (pre-purchase)
 Upgrade requests
 Returns

Tel.: 0180-48 99 999 (0.20 EURO/per call from German land
lines) 
Monday ? Thursday: 9:00 am ? 12:30 pm and 1:15 pm ?
6:00 pm 
Friday: 9:00 am ? 12:30 pm and 1:15 pm ? 5:30 pm 

Email infoservice@magix.net 
Post: MAGIX AG 

Borsigstr.24 
32312 Lübbecke 
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Serial number
 A serial number is included with each product, and although it is not required for the installation of the
software, it does enable access to additional bonus services. Please store this number in a safe place. 
What can a serial number do?
 A serial number ensures that your copy of MAGIX Photo Manager 10 Deluxe is clearly assigned to you
and only you, and it makes improved and more targeted customer service possible. Abuse of the
software can be prevented with a serial number, since it ensures that the optimum price/performance ratio
continues to be offered by MAGIX. 
Where can the serial number be found?
 The serial number can be found on the reverse side of your CD/DVD case. If your product, for
example, is packed in a DVD box, then you'll find the serial number on the inside. 
For versions that have been especially optimized for the Internet (download versions), you'll receive your
serial number for activating the software directly after purchasing the product via email. 
When will you need the serial number?
 The serial number is required when you start or register MAGIX Photo Manager 10 Deluxe for the first
time. 
Note: We explicitly recommend registering your product, since only then are you entitled to get program
updates and contact MAGIX Support
. Entering the serial number is also required for activating codecs. 
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More about MAGIX
In this chapter
MAGIX Online World
MAGIX News Center
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MAGIX Online World
 Discover the possibilities of MAGIX Online World. Whether it's for your photos, videos, or music, we
have just the right solution for you. 

MAGIX Online Album
 MAGIX Online Album
 lets you publish your photos and videos directly on the Internet. You can also play your music as MP3s
in the Online Album. Create your personal album website in no time with your own Internet address, and
showcase everything that's fun about multimedia to the world. 
For example, you can upload especially impressive photos or entire slideshows as videos straight from
your MAGIX program. Pictures you put on your website can be downloaded with ease from the comfort
of your own home and integrated into your slideshow. 

MAGIX Website Maker
 MAGIX Website Maker helps you create a personal Internet showcase with a professional design in
just a few mouse clicks ? without prior knowledge, including your own chosen domain and email
address. Publish slideshows and videos and accessorize your site with music and various effects ?
anything from a simple business card to a fireworks display of effects, professional or private ? show
your best side! 
More about this topic can be found under MAGIX Website Maker.

 magix.info
 Help and get help - Directly from within the program, you'll be able to access magix.info, the new
MAGIX Multimedia Knowledge Community
. In the Multimedia Knowledge Community, you'll find answers to all of the most frequently asked
questions about MAGIX products and multimedia in general. Couldn't find an answer to your particular
question? No problem, just ask the question yourself. 

You can go to magix.info
 in the "Online" menu, or via this button. 

MAGIX Blog Service
 With MAGIX Blog Service, YOU make the news! Share your thoughts, experiences, and news with a
worldwide audience in no time using your own interactive online multimedia journal. Invite family, friends,
and acquaintances to join in and enter their comments! A free MAGIX Online Album belongs to the 
MAGIX Blog Service
 so that you always have full control over your contributions. 
You can also read the FAQ (frequently asked questions) on the Internet.

 MAGIX Online Print Service
 MAGIX Online Print Service is perfect for getting your pictures processed online or printed as photo
gifts on mugs, t-shirts, or calendars. 

Catooh
 If your project is missing pictures, videos, DVD menus, sounds, or samples, then you should have a look
at the huge selection available at Catooh. There you'll be able to buy media in excellent quality for low
prices: DVD menus, Slideshow Maker styles, decorative elements, 3D power effects, 3D transition
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series, MAGIX Soundpools, songs, ringtones... Perfectly suited to all MAGIX photo, video, and music
projects. 
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MAGIX News Center
MAGIX can supply you with all of the latest information about
your software. In the MAGIX News Center, you will find all of
the links to current online tutorials as well as tips & tricks on
individual topics or software application examples. 

You will also be informed of the availability of brand new updates and patches for your program as well
as special offers, contests, and surveys. 
The news is split into three color-coded sections: 

 Green for practical tips & tricks for your software
 Yellow reports the availability of new patches and updates for your product
 Red for special offers, contests, and surveys
 And if there are no new messages, then the button will be grey

All available information is shown as soon as you click on MAGIX News Center. If you click on one of
the news items you will be forwarded to the corresponding website. 
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Introduction
In this chapter
What is MAGIX Photo Manager 10 Deluxe?
What’s new in MAGIX Photo Manager 10 Deluxe?
Supported formats
Overview of the program screen
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What is MAGIX Photo Manager 10 Deluxe?
 MAGIX Photo Manager 10 Deluxe is the perfect tool for digital photographers and collectors of digital
photos. It is a photo album, photo optimizer, photo manager and photo viewer in one. 
Is your computer full of unorganized photos from your digital camera? Masses of photographs lying
around in envelopes or photo albums waiting to be scanned while your digital camera keeps on delivering
new pictures that will have to be saved somewhere. Masses of photographs lying around in envelopes or
photo albums waiting to be scanned while your digital camera keeps on delivering new pictures that will
have to be saved somewhere. 
MAGIX Photo Manager 10 Deluxe can display, restore, organize, enhance, and perfectly print all those
photos, present them in a slideshow and even burn them all onto a CD or DVD. 
There are lots of ways to use it: 

 Arrange photos: A sophisticated database lets you find and gather photos from anywhere on
your computer.

 Import photos: Simply connect your digital camera or scanner to your computer and transfer the
photos to your hard drive.

 Sort photos: (Categories, Create categories)Move specific photo collections as one group and
move them to the relevant category (vacation photos to "Vacation", family photos to "Family",
and so on).

 Select photos: Choose, for example, all images showing a certain person or let MAGIX Photo
Manager 10 Deluxe pick the pictures that are really worth showing.

 Retouch & restore photos: Retouch and restore your photo collection quickly. You can
straighten out crooked photos by drawing a line with the mouse. Red eyes can be removed with
a click. The original photo file is never changed, allowing you to experiment without any worries.

 Present photos: (Export, Present your photos) All photos can be collected in a playable photo
album and presented in full-screen. Photo albums, posters, and individual photos may be printed
out immediately or archived on CDs or DVD.
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What’s new in MAGIX Photo Manager 10
Deluxe?
 Assistant for quickly finding the best shots
 With the help of the new assistant for finding and compiling the best shots, you will quickly find the
photos to show others in MAGIX Photo Manager 10 Deluxe. The assistant will analyze all images on
your computer and list the images that fit your selection criteria. This function can be accessed via the
"Selection" under the "Select best shots"
 option. 

Crisp presentations
 Would you like to show your photos in perfect focus? Even slightly unfocused photos will become a
pleasure to look at with the "Sharpen" presentation fucntion. Two settings are availabel for improvement
in MAGIX Photo Manager 10 Deluxe ? thsi way, your images will always be optimally presented.
Nothing will change in the original image file; this effect will be applied only during viewing in MAGIX
Photo Manager 10 Deluxe. You can find the sharpen function in image preview in the tool bar. 

Upload to Facebook
 FacebookTM

 is one of the most popular Internet communities. This is partially due to the fact that it offers users an
easy way of sharing news, links or photos and videos. Thanks to the useful upload function of MAGIX
Photo Manager 10 Deluxe, you can select the photos to be uploaded to your Facebook profile and then
transfer them using the "Online -> Uploaded media to other web services -> Upload media to
"Facebook". 

Improved travel route animation
 Now, you can even animate travel routes in MAGIX Photo Manager 10 Deluxe. Go to travel route
animation via "Edit > Create map". After entering a travel route, click on the "Animation" button and
select a mode of trabsportation from the appearing drop-down menu. At the end, you can export the
route as a video clip, which you can embed into a slideshow, for example. 

MAGIX Rescue Your Notebook Data
 As a bonus, MAGIX Photo Manager 10 Deluxe contains the MAGIX Rescue Your Notebook Data
program. This program allows you to quickly and easily make backups of all data on your computer or a
certain folder (e.g. all photos). You can read about how the program works in the program help of
MAGIX Rescue Your Notebook Data. 

Other Enhancements
  ImprovedPanorama image montage for even better panoramas, especially with complex

motifs.
 Improved presentation mode with automatic pans and zooms, music and "laser pointer".
 Now with the image editing program MAGIX Photo Designer, which lets you quickly optimize

photos.
 New order assistant for ordering photo prints, books, calendars and photo gifts.
 Improved camera import, especially for videos and audio files.
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Supported formats
 Photo import
: JPEG (*.jpg; *.jfif; *.jpeg; *.jpe), Windows Bitmap Formats(*.bmp; *.dib; *.rle), Tagged Image File
Format (*.tif; *.tiff), Kodak Photo CD (*.pcd), Targa (*.tga), Adobe Photoshop PSD (*.psd, not all
features), Portable Network Graphic (*.png), Portable Graymap PGM (*.pgm), Portable Pixelmap
PPM (*.ppm), Sun Raster File (*.RAS), PCX format (*.pcx) and RAW formats from many different
camera models. 
Photo export
: JPEG (*.jpg; *.jfif; *.jpeg; *.jpe), Windows Bitmap Formats (*.bmp; *.dib; *.rle, nur 24Bit RGB),
Tagged Image File Format (*.tif; *.tiff, uncompressed/with JPEG compression), Targa (*.tga), Adobe
Photoshop PSD (*.psd, not all features), Portable Network Graphic (*.png), Portable Pixelmap PPM
(*.ppm), Sun Raster File (*.RAS), PCX format (*.pcx) and RAW formats from many different camera
models. 
Video import: DirectShow®

 compatible standard formats with installed codecs (AVI, MOV, MJPEG, MPEG etc.) and WMV9 
Video export: DirectShow® compatible standard formats with installed codecs (AVI, MOV, MJPEG,
MPEG etc.), WMV9, RealHelixTM

, MXV, WMV HD 
Audio import: 
Wave, MP3, OGG VORBIS 
The integrated image processing program, MAGIX Photo Designer, can import the following image
formats: JPEG, TIFF, GIF, BMP, RLE, DIB, PNG, TGA, PCX, EMF, WMF, PPM, PGM, PBM,
PSD, RAS, IFF, LBM and Photo CD. Export of following files is possible: JPEG, TIFF, BMP, PNG,
TGA, PPM, PGM, PSD, RAS, IFF, LBM and PCX. 
Note:
 If you want to use other image formats in MAGIX Photo Manager 10 Deluxe, you must convert them
first. Load the image into MAGIX Photo Designer, export it in the desired format, then load it into
MAGIX Photo Manager 10 Deluxe. 
Audio export: 
Wave, MP3, OGG VORBIS. 

Sound in picture support
 Some digital cameras have an audio recording function so that you can save an audio file with each
photo. The audio file is automatically included in the database overview when you import the photo from
the camera. 
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Overview of the program screen

Menu bar
: Opens all possible functions and services in MAGIX Photo
Manager 10 Deluxe. 
Activate/deactivate advanced mode in MAGIX Photo Manager
10 Deluxe. 
Toolbar: Provides access to the most important functions in
MAGIX Photo Manager 10 Deluxe. 
Photo Manager
 in the form of folders and a database for organizing your files. 
Photo overview
 to display the contents of your folders, albums, and
slideshows. 
Albums
: Area for creating and editing photo albums. 
Photo overview toolbar
. 

Tip regarding special program versions:
 This documentation describes the full functionality of MAGIX Photo Manager 10 Deluxe. However, you
may be using a restricted version of MAGIX Photo Manager 10 Deluxe, and full functionality may not be
available. 
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Tutorial videos
 MAGIX Photo Manager 10 Deluxe contains a series of tutorial videos which descriptively show how
the program is used. In the following, you will find a list of all of the tutorial videos and a corresponding
help topic which will provide you with additional information about the associated topic. 
Video Help topic
Program interface Program interface

 Quick Start
Optimize and manage photos Optimize photos

 Manage
Print and present Presenting on your PC

 Present online
 Print

Import pictures Import
Burn files on CD & DVD Burn
Export and convert files Export
Working with categories Create categories
MAGIX Online Album MAGIX Online Album
Optimize photos Optimize photos
Panoramas and photo montages Create panoramas
MAGIX Online Print Service Print and order pictures 
Note
: In certain versions of MAGIX Photo Manager 10 Deluxe, e.g. the download version, the tutorials are
not included. 
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Quick start
In this chapter
Manage photos
Importing photos
Scan photos
Viewing photos
Finding photos
Create categories
Select pictures according to criteria
Optimize Photo
Create slideshows and photo albums
Print photos
Present your photos
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Manage photos
 With MAGIX Photo Manager 10 Deluxe there are several ways to get your pictures onto your
computer. You can either import photos directly from your digital camera, or scan previously developed
pictures. You can access any graphic, audio and video files found on your hard drive using the folder
function. 

 Every folder can be
opened with a
mouse-click. The
contents will be listed in
the preview window.

 By clicking on the
"New" symbol you can
create a new folder.

 With the red cross you
can move foders or files
into the recycling bin.

 To change the name of a
folder, click "Rename
selected folder". 

 Clicking on the yellow star ("Add selected folder to Favorites") adds a folder to your "Favorites"
folder. This list can be opened via the "Favorites" button. 

You can have your photos filed into the database and search for them later on according to their creation
date, keywords, or genre. Everything takes place in the intelligent virtual MAGIX Photo Manager 10
Deluxe database ? without time-wasting file shifting or copying. 

 It is recommended that you add folders with photos to the database. This function can be
initiated at any time directly from the "Database" > "Add folders" menu.

 Photos imported from the camera are detected automatically and displayed in the photo
overview. The same applies to every photo that you search for in Explorer. 

If you change certain folders outside of MAGIX Photo Manager 10 Deluxe, e.g. you copy new photos
into your photo folder, you should check if the new or changed photos are also present in the MAGIX
Photo Manager 10 Deluxe folders. Select the option "Monitor folder" in the "Database" menu. 
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Importing photos
 MAGIX Photo Manager 10 Deluxe directly accesses digital cameras and their storage media, and then
copies the image files to your hard disk. Select the file format you wish to save the photos in during this
process. Most cameras identify themselves automatically as so-called "removable storage devices", and
therefore appear as separate drives in Windows™ Explorer. 
If the import dialog doesn't open automatically after connecting your digital camera, click "Import".
MAGIX Photo Manager 10 Deluxe will scan your PC for connected digital cameras or for storage
media (e.g. compact flash cards). This will take a moment. As soon as the interfaces have been checked,
the "Photo import
" dialog will open. You will be able to see all of the photos saved on your camera (or the selected storage
medium). 

You have the option of setting the save location for your new pictures under "Target folder
". 
"Import settings" lets you erase photos from your camera after they have been imported, convert file
formats into a certain format during transfer, and specify the author and category with "Image
properties
". 
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Scan photos
 You need a TWAIN-compatible scanner connected to your PC to scan physical photos. "Twain" is the
designation of the universal interface between image editing devices (digital cameras and scanners) and
image editing programs. 
Follow these instructions to scan your first picture: 
Step 1:
 Before you start scanning, make sure that your scanner's TWAIN software is installed. If this is not the
case, install the software and reboot your computer. 
Step 2:
 If your scanner is connected, switched on, and ready to operate, then place your picture in the scanner. 
Step 3:
 Open MAGIX Photo Manager 10 Deluxe and select "File > Scan > Select source". 
Step 4:
 Choose the device you would like to use in the dialog. This step will no longer be necessary if you
continue using the same device. 
Step 5:
 The scan window of your scan software will appear. Specify the resolution and color depth in this
window. 
When the scan is complete, the TWAIN software should close automatically and MAGIX Photo
Manager 10 Deluxe should now display the newly created image file. 
The newly acquired pictures will be saved in the "My Photos" folder under C:\ in MAGIX\MAGIX
Photo Manager 10 Deluxe, which was created during installation. 
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Viewing photos
 There are many practical options for viewing your pictures with MAGIX Photo Manager 10 Deluxe. 

These can be accessed easily via the
small menu above the second arrow
button above and to the right next to
the path information. 

You can switch between miniature view and filmstrip view or you can navigate through the file list like in
Windows Explorer. 
Below the preview window you will find arrow buttons for turning pages. The 1:1 button for viewing the
pictures in the original size, and the fader for increasing or reducing the size of your preview pictures. You
can use the "Optimize" button to switch into the optimize mode for your photos. 
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Finding photos
 The search function helps you find photos on the hard drive or in the database. 

Click the "search" function button. 

You can search the entire hard disk or limit the search to a certain drive or directory. After a search, all
found objects will be represented with a preview picture in the overview. 
Hard disk quick search:
 You can enter the file name, approximate size and creation date into the search dialog. 
Expert search in the database:
 Here you can control the search using characteristics. Up to three details can be searched for at the
same time by using the "AND" or "OR" logical operators. 

 "AND" means: Only those files will be listed that match all criteria.
 "OR" means: Only those files will be listed that match at least one of the criteria.
 You can also set "conditions" and "comparison elements". 

Search for EXIF contents:
 EXIF files are information about the digital image files: This includes creation date, file size, format, as
well as photo-specific details like shutter speed, diaphragm and exposure. 
Search for similar photos: This function is explained in "Select images according to criteria"
. 
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Create categories
 Select "Categories" to arrange your photos according to theme. You will find that some categories have
already been suggested ? hobby, friends, animals, nature, etc. You can add new categories and edit or
delete the available categories. Please note: The categories are not "actual" file folders that you create on
your hard disk, but rather individual links to files that could be found anywhere on your system. 
This is how you file your pictures under categories: 

 Step 1: Open the folder containing the photos you would like to sort into categories. 
 Step 2: Next, click the "Categories" tab and drag the selected images to the desired category via

drag & drop. You can even sort photos into several categories simultaneously.
Alternatively, you can also open the stamp first, select the
category, and then stamp every picture that should be
assigned to a specific category. 
You can also create individual categories. To do so, click on
the "New category" button and name the category. 
You can also rename existing categories. Click on the
"Rename" symbol to do this. 

Open categories
: The images belonging to a category will be displayed as soon as one category is selected. The ability to
select more than one category is very useful: For example, you can select the categories "Vacation" +
"Summer" + "Friends", and only pictures that have been sorted under all these categories, or photos of
friends with whom you have been on holidays together will show up. Multiple marking of photos takes
place like this: while holding the "Ctrl" key down, click all desired categories with the mouse. 
Add a rating
: Every picture can be rated with 1 to 5 stars which you will then see in the miniature view of the image.
The stars in "My Ratings" each form a special category, and these can all be assigned just like the other
categories. 
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Select pictures according to criteria
Click on "Selection" in order to open the various
options for selecting images: 

 Select the best shots
 Tag people on pictures
 Search for similar photos

In this section:
Select the best shots
Tag people on photos
Find similar photos...
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Select the best shots
 Here you can select the criteria, according to which MAGIX Photo Manager 10 Deluxe will
automatically create a folder with photos. This way you can create a selection of the best shots, for
example, or avoid images with a certain motif, or pick pictures with a certain person, etc. MAGIX Photo
Manager 10 Deluxe serches the photos or folders you indicated and creates the selection, relieving you
of the time-costly sorting by hand. 
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Tag people on photos
 MAGIX Photo Manager 10 Deluxe can automatically search your photos for faces and assign them to
persons whom you have identified earlier. 
Identify persons and create a category for them:

  First select an image, where faces are easily recognizable. 
 Now, click on "Selection" and choose "Tag persons on photos".
 The "Identify persons" dialog now opens.

 Make a rectangular selection around the first face if <Programmanme> does not recognize it on
its own: The face will open in a magnified view, where you have to first select both eyes and then
the mouth using the mouse.

 Then click on the right on "New person" and enter the person's name.
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MAGIX Photo Manager 10 Deluxe will then
analize the entire database. Every photo,
where the face has been found will receive a
little symbol with the face. In addition, you will
find all persons selected by you and the
photos, where they are found in "Categories" (
Categories, Create categories
). 

Note
: If an already identified person has not been found on a different photo, you can tag him or her manually
via the "Identify persons" dialog. 
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Find similar photos...
 With this function you can quickly find the images, similar to your selected photo. 

 First, select a starting image.
 Then on "Select" and choose "Search for similar photos".
 A tab will open "Search for similar photos" in the Search dialog.

 Under "Search in the database" specify where MAGIX Photo Manager 10 Deluxe should search
for similar photos. Under "Results", specify how the result should be displayed. 

Depending on the number of photos, the search can take some time. At the end, you will see a list of
similar photos in the format selected by you. 
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Optimize Photo
 You can optimizing all photos from a folder while viewing them and compile them into a photo album. 

To do so, click on "Optimize". 
You can access the picture editing functions on the
left-hand side. 

Basic functions
  Exposure: Brightness, contrast, focus
 Color: Auto color, red eye correction
 Image section
 Straighten horizon 

Advanced functions:
 (click the "Advanced mode" selection box in the top right): 

 Advanced color modulation: White balance, coloration, black/white, sepia, saturation, color
temperature

 Text in picture
 Special functions: Remove curved lines, camera panorama

With the help of the arrow keys you can select the large view of all the photos in the current folder one
after the other. To sort the best photos into a photo album, press the "S" key after optimization (or click
on the "To album" button). The selected photo will then be sorted into the existing photo album or into a
new one. 
In this section:
Basic functions
Paste text
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Basic functions
 If your pictures don't have enough light or contrast, or you have cloudy colors because of fog, then use
the "Auto color" and "Auto brightness". 
"Adjust brightness" and the "Gamma" setting sets an even brightness if a dark lighting at dusk or nighttime
snapshots has robbed your shots of color. Additionally, shadows, mid-tones, and light as well as the
entire image may be linearly adjusted in terms of their brightness. 
"Contrast" and "Image sharpness" offers additional options to edit the contours of your photos
afterwards. 
Click on the "Redeye" tool and let MAGIX Photo Manager 10 Deluxe automatically search for redeye
on all faces. Or, select the eye with the existing tool sizes. You don't have to worry about marking
individual pixles. Using the mouse, you can change the size of the tool: With the left mouse key held
down, you can drag the perimeter of the tool to expand it. 
"Cropping" can be done either freehand or using a template for aspect ratio. First, click on the "Crop"
button and drag the desired area over the image with the mouse button depressed. Then confirm the
selection with "Apply". 
If your landscape photo is a little crooked, then you can use the "Straighten horizon" function to simply
level it out - the horizon will be shifted so that it is exactly straight. 
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Paste text
 To create a caption for an image, enter your text in "Advanced functions" into the "Image text" field.
Drag the text in the preview window to the desired position. 
Specify style, color, and shadow via "Options" for the font. You can also change the color of the
background behind the text. If you choose a low transparency, you will get an unobtrusive, but readable
title. 
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Create slideshows and photo albums
 All images in a folder can also be played back as a slideshow. 

 Select an image and click the Slideshow
button. 

MAGIX Media Viewer will open and the slideshow will play back automatically in full-screen mode. 
 To activate the navigation buttons, move the mouse to the top or bottom edge of the image.
 There is a default display setting of 7 seconds for each photo before the next one appears after

an automatic fade. You can also change these settings later (gear symbol). 
 You can manually flip forward and backward between images as you like by clicking on the

arrows. 
 To leave slideshow mode, press the "Esc" button and close the program.

Note:
 A help file for all of the functions of Media Viewer may be accessed via "F1" on your keyboard. 

Play album as slideshow
 Different photos can be compiled in a single album and then be viewed comfortably in sequence,
regardless of which folder they are in. 
Step 1: In the overview window, you can select as many individual images as you like from any folder,
and then click on "To album
". 

The album area to the right will become visible
and the image will be sorted into the album
section. This way, you can always keep an eye
on the contents of your current album. 

Step 2:
 In addition to photos, you can also add music you like to the album by clicking it or dragging it. The
tracks are played in the order in which they are listed. You can move the links created in your album
anywhere you like in the list until the picture and music order looks the way you want it to. The storage
location of your original files is not affected by this in any way. 
Step 3:
 After you have added all of the media you want to the album and arranged it, click on the first photo in
the album and then on the "Slideshow" button to play back the slideshow. 
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Print photos
 Tip
: Use "Optimize" on MAGIX Photo Manager 10 Deluxe's main screen to adjust images with redeye or
color problems in order to get the best possible results. 

1.
 Select all images which you would like to print. 
2. To open the dialog, click the "Print
" button. 

Layout
: You can set how many pictures should be printed per page. You can choose from between 1 and 8
pictures per page. The more pictures found on any page, the smaller they will appear. With "Contact
sheet" you can have a type of index for all pictures printed. All pictures are ordered in mini format on one
page. Of course, you can also print your pictures in standard formats (9x13 and 10x15). 
Options
: Activate options by checking them off (and leave those unchecked which you don't want to activate).
For example, if you've saved comments on an image and want them to be visible on the printed page,
then activate "Print comments". If you've optimized several images or added effects, place a check next
to "Print optimization effects" so that the adjusted photos appear as you want them to. Click on "Default
settings" to reset things to their standard values. 
Quick settings
: This displays several typical settings for print jobs like posters and postcard puzzles, etc. Use one of
these settings and you will have to make sure that there are no adjustments to the settings under
"Options". 
Copies
: Set how many copies are to be created for the current print job. 
Landscape format
: Activate this button to print the image in a landscape (horizontal) format. 
Setting
: Open your printer's settings and customize them to meet your requirements. 

Click "Print" to start the print process. 
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Present your photos
 Digital photos on the PC should not be the goal in itself. For this reason, MAGIX Photo Manager 10
Deluxe offers an entire range of possibilities of what to do with your photos: 

Burn
 You will often want to burn your photos to disc, e.g. to present them on a friend's PC. Click the "Burn
" button to get started. 

In the disc selection dialog, you can burn selected
images like normal to CD or DVD ("CD/DVD
" option), or you can select a special presentation
method. 

 Slideshow: This enables automatic playback of individual photos on a PC.MAGIX Media
Viewer will be burned to the disc for this purpose. 

 WMVHD: This converts your media into a high-resolution video file for optimum playback
quality on a PC. 

 JPEG disc: This feature enables automatic playback of individual photos on TV via a compatible
DVD player.

 Export
 Other presentation options can be accessed via the "Export
" button. 

Depending on whether or not you have selected
individual photos or an album, the export dialog offers
different options (you can select an album by clicking on
one of the displayed photos in the album display to the
right). A couple of examples: 

 Screensaver: To do this select individual photos, click on the "Export" button, and then select "
Create and install screensaver" ? and voilá! ? your slideshow will be flickering on your
monitor while your computer idles.

 Desktop background: You can create your own desktop show in the same way. The photos
will be displayed in a slideshow as a desktop background. A great function if you just can't
decide which one is your favorite picture! 

 Mobile devices: If you want to add new pictures to your portable player, select "Mobile
devices" in the export dialog for albums, or for individual images the option "Transfer to
mobile device".

 Online Album
 You can also put your pictures from MAGIX Photo Manager 10 Deluxe directly onto your own photo
website and then present them to friends with a link. 

Use the "Online album
" button to access your online album at any time if you
want to provide it with new content. 

 Step 1: Select the media which you would like to upload (photos, music, videos, or even a
complete album).

 Step 2: Sign up using your email address and a password for MAGIX Online Album. If you
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haven't registered yet, then you can do so directly in a few steps.
 Step 3: Enter which resolution the pictures placed online should have. 
 Step 4: You can customize your personal web page individually. By sending an email link, an

e-card, or a photo gift, you can send messages to your friends and invite them to visit your Online
Photo Album. 

Further information and help can be found at www.magix.com

 Photo prints
 Digital is good, but holding something in your hands is even better. For this reason, you should be able to
quickly get your hands on high-quality prints when you want them. To do this, use the integrated MAGIX
Online Print Service. 

Click the "Photo prints
" button. Single photos or whole albums can be
easily uploaded for printing. For more information
and current prices and offers, please visit
www.magix-prints.com 
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Burn
 You will often want to burn your photos to disc, e.g. to present them on a friend's PC. Click the "Burn
" button to get started. 

In the disc selection dialog, you can burn selected
images like normal to CD or DVD ("CD/DVD
" option), or you can select a special presentation
method. 

 Slideshow: This enables automatic playback of individual photos on a PC.MAGIX Media
Viewer will be burned to the disc for this purpose. 

 WMVHD: This converts your media into a high-resolution video file for optimum playback
quality on a PC. 

 JPEG disc: This feature enables automatic playback of individual photos on TV via a compatible
DVD player.

 Export
 Other presentation options can be accessed via the "Export
" button. 

Depending on whether or not you have selected
individual photos or an album, the export dialog offers
different options (you can select an album by clicking on
one of the displayed photos in the album display to the
right). A couple of examples: 

 Screensaver: To do this select individual photos, click on the "Export" button, and then select "
Create and install screensaver" ? and voilá! ? your slideshow will be flickering on your
monitor while your computer idles.

 Desktop background: You can create your own desktop show in the same way. The photos
will be displayed in a slideshow as a desktop background. A great function if you just can't
decide which one is your favorite picture! 

 Mobile devices: If you want to add new pictures to your portable player, select "Mobile
devices" in the export dialog for albums, or for individual images the option "Transfer to
mobile device".

 Online Album
 You can also put your pictures from MAGIX Photo Manager 10 Deluxe directly onto your own photo
website and then present them to friends with a link. 

Use the "Online album
" button to access your online album at any time if you
want to provide it with new content. 

 Step 1: Select the media which you would like to upload (photos, music, videos, or even a
complete album).

 Step 2: Sign up using your email address and a password for MAGIX Online Album. If you
haven't registered yet, then you can do so directly in a few steps.

 Step 3: Enter which resolution the pictures placed online should have. 
 Step 4: You can customize your personal web page individually. By sending an email link, an

e-card, or a photo gift, you can send messages to your friends and invite them to visit your Online
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Photo Album. 
Further information and help can be found at www.magix.com

 Photo prints
 Digital is good, but holding something in your hands is even better. For this reason, you should be able to
quickly get your hands on high-quality prints when you want them. To do this, use the integrated MAGIX
Online Print Service. 

Click the "Photo prints
" button. Single photos or whole albums can be
easily uploaded for printing. For more information
and current prices and offers, please visit
www.magix-prints.com 
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Export
 Other presentation options can be accessed via the "Export
" button. 

Depending on whether or not you have selected
individual photos or an album, the export dialog offers
different options (you can select an album by clicking on
one of the displayed photos in the album display to the
right). A couple of examples: 

 Screensaver: To do this select individual photos, click on the "Export" button, and then select "
Create and install screensaver" ? and voilá! ? your slideshow will be flickering on your
monitor while your computer idles.

 Desktop background: You can create your own desktop show in the same way. The photos
will be displayed in a slideshow as a desktop background. A great function if you just can't
decide which one is your favorite picture! 

 Mobile devices: If you want to add new pictures to your portable player, select "Mobile
devices" in the export dialog for albums, or for individual images the option "Transfer to
mobile device".

 Online Album
 You can also put your pictures from MAGIX Photo Manager 10 Deluxe directly onto your own photo
website and then present them to friends with a link. 

Use the "Online album
" button to access your online album at any time if you
want to provide it with new content. 

 Step 1: Select the media which you would like to upload (photos, music, videos, or even a
complete album).

 Step 2: Sign up using your email address and a password for MAGIX Online Album. If you
haven't registered yet, then you can do so directly in a few steps.

 Step 3: Enter which resolution the pictures placed online should have. 
 Step 4: You can customize your personal web page individually. By sending an email link, an

e-card, or a photo gift, you can send messages to your friends and invite them to visit your Online
Photo Album. 

Further information and help can be found at www.magix.com

 Photo prints
 Digital is good, but holding something in your hands is even better. For this reason, you should be able to
quickly get your hands on high-quality prints when you want them. To do this, use the integrated MAGIX
Online Print Service. 

Click the "Photo prints
" button. Single photos or whole albums can be
easily uploaded for printing. For more information
and current prices and offers, please visit
www.magix-prints.com 
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Online Album
 You can also put your pictures from MAGIX Photo Manager 10 Deluxe directly onto your own photo
website and then present them to friends with a link. 

Use the "Online album
" button to access your online album at any time if you
want to provide it with new content. 

 Step 1: Select the media which you would like to upload (photos, music, videos, or even a
complete album).

 Step 2: Sign up using your email address and a password for MAGIX Online Album. If you
haven't registered yet, then you can do so directly in a few steps.

 Step 3: Enter which resolution the pictures placed online should have. 
 Step 4: You can customize your personal web page individually. By sending an email link, an

e-card, or a photo gift, you can send messages to your friends and invite them to visit your Online
Photo Album. 

Further information and help can be found at www.magix.com

 Photo prints
 Digital is good, but holding something in your hands is even better. For this reason, you should be able to
quickly get your hands on high-quality prints when you want them. To do this, use the integrated MAGIX
Online Print Service. 

Click the "Photo prints
" button. Single photos or whole albums can be
easily uploaded for printing. For more information
and current prices and offers, please visit
www.magix-prints.com 
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Photo prints
 Digital is good, but holding something in your hands is even better. For this reason, you should be able to
quickly get your hands on high-quality prints when you want them. To do this, use the integrated MAGIX
Online Print Service. 

Click the "Photo prints
" button. Single photos or whole albums can be
easily uploaded for printing. For more information
and current prices and offers, please visit
www.magix-prints.com 
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Interface and functionality
 This chapter will provide you with an overview of the functions available in MAGIX Photo Manager 10
Deluxe and where to find them. 
In this chapter
Advanced mode & Easy mode
Toolbars
Navigation and info tabs
Photo overview
Album view
Optimize view
Slideshow monitor
Keyboard shortcuts
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Advanced mode & Easy mode
 Many advanced mode functions will not be necessary for every process in MAGIX Photo Manager 10
Deluxe. For this reason, you can choose to limit the program to basic functionality. 

All advanced mode functions will be
hidden in Easy mode, but to use them
they can always be shown again with a
simple click. 

Easy mode screen

 Additional functions in advanced mode
 which can be hidden in easy mode: 

 Database menu and Database tab
 The Security, Services, and Tasks menus
 Categories (Categories, Create categories) tab
 File information tab
 "1:1" and "fit" in the Photo overview buttons
 In the "Optimze" area: Advanced functions for image editing and Edit image externally
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Toolbars
Import: Opens the import dialog. Once you have
connected your external device
 (e.g. digital camera), all pictures will appear here
automatically and, if desired, they can be copied into
the corresponding folder. 
Or switch to the Online media
 area and download images from your online album. 
In the Folders
 area, you can enter a folder to be added to MAGIX
Photo Manager 10 Deluxe's database. 
Selection: MAGIX Photo Manager 10 Deluxe finds
suitable pictures for you. Choose between "Create
representative selection", "Recognize faces on
pictures", and "Find similar pictures
". This saves you from having to take the time to sort
manually. 
Export: Exports
 the album or one or more selected photos as videos,
desktop backgrounds, screensavers, and more. 
Or load your media into your Online Album
 to make it available to everyone. 
Print: Print images
 gives you the option of printing your images at home
with your own printer. 
Switch to Order photo prints
 to order your photos for delivery to your home with
a few clicks. 
Or create a photo album with your images for special
occasions. 
Burn:
 This button opens the burn dialog. Select which
format you want to use to burn your files to CD or
DVD. 

Slideshow: Opens MAGIX Media Viewer
 and starts the slideshow with the selected photos. 

Online Album: Don't just upload your media to your
Online Album via Send media, manage it too in
MAGIX Photo Manager 10 Deluxe via Manage
media
. 
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Order your photos
 to your home with just a few clicks via the Internet.
You can order photos, posters, printed t-shirts, photo
albums, or other great gift ideas. 
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Navigation and info tabs
The navigation and info tabs in the Photo
Manager allow you to organize the data in
the form of folders and database entries. 

In this section:
Folder
Photos and videos
Calendar
Categories
Database
Albums
File information
Preview / Media Player
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Folder

 "Folder" displays the actual existing file system of your PC. You can open every folder and show its
contents to navigate through the structure of your PC. Every folder can be opened with a mouse click. 
Button

New folder
: Creates a new subfolder in the selected folder. 
Rename selected folder
: Use this button to open a small dialog where you can
change the name of the selected folder. 
Delete
: Deletes the selected folder. 
Add to favorites
: Pressing this button adds a folder to your "Favorites"
folder. The list can be launched via the little arrow. 
Launch the Explorer's functions: Besides the above-named
functions, there are also: 
Copy into folder
: The previously selected photos will be copied into the
chosen folder, and you can either specify this directly or
select it using the folder symbol. 
Open Windows Explorer
: The selected folder will be opened with the Windows
Explorer. 
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Photos and videos

 This tab contains a list of all folders with photos and/or videos which were read by MAGIX Photo
Manager 10 Deluxe (also using its search function). 
Important!
 It is not the listed folders, but rather the actual file folders that display the connections to the file folders,
as is the case with categories. Changes are not related to the entries in the list, but rather the folders
themselves! If you delete a folder here, then it will also be deleted from your computer... 
Buttons

Adding a new folder is fast and easy. 

Rename the selected folder. 

Arrange the folder according to specific characteristics like
name, size, date, etc. 
Delete the selected folder from the database and from your
computer. 
Launch any of the functions which are available to you for
folder management. Besides the functions named above, you
can also: 
Change the date of creation
: This is most important for sorting according to date.
Correct information about the folder if it is not correct. 
Set preview images for folders
: Specify preview images here which make the contents of a
folder clear. 
Hide folders
: You can hide folders if you do not want them to be
displayed. They won't be deleted from the computer. 
Hide all music folders
: Many music folders contain 1 or 2 images for the album's
cover. For this reason, these folders are normally listed here.
If this option is activated, then all folders which contain more
music than image files will be hidden. 
Show hidden files
: If you have hidden folders, then you can display them again
later. Maybe you're looking for a certain image which may
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be hidden, or you would like to show a folder again. The
"Show folder" option will appear in the folder's options
menu. 

Page 46



Calendar

 The "Calendar" folder organizes photos by date. Clicking on a specific date in the calendar, displays all
photos from anywhere on your system that contain the selected date information. 
You can also click on the year or the month. Then all the entries for the selected year or month will be
shown. 
Functionality:
 For photos from digital cameras meta information, including the date of creation, is recorded in the file
when a photo is taken. This information is the basis of the calendar function. Picture files that don't have
any such meta information will be ordered according to the date they were copied to the hard disk. 
The ordering of the calendar is based on when the photos were taken. 
Hierarchical order of the calendar:
 As the top-most level only the years are listed out at first. By clicking on the plus in front of the
corresponding years, months can be opened. Now click on the plus again to see the days. 

Expand all:
 Clicking this button expands the display to all levels:
years, months, and days. 
Collapse all:
 Clicking this button reduces the levels displayed to
only the top level (years). 
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Categories

 In the "Categories" tab, you will find themes for sorting your files. 
Categories have been submitted in MAGIX Photo Manager 10 Deluxe for you. These may be deleted or
renamed as you see fit. A picture may also be assigned to several categories. 
Please note
: The categories are not "actual" file folders that you create on your hard disk, but rather individual links
to files that could be found anywhere on your system. 

Buttons
Add new categories simply and easily. 

Give existing categories a new name. 

Delete categories. The images which are assigned to this
category will not be deleted. 
Activate this function and click on the images which should
be assigned to the active category. 
Activate the eraser tool and delete the category assignments
by clicking on them. The images will not be displayed any
longer in the category. 
Launch any of the functions which are available to you for
category management. Besides the functions named above,
you can also: 
Large icons
: Display the icons for categories either large or small. 
Summarize multiple selection
: Select multiple selections to determine whether or not all
images in the respective category should be displayed (large
selection), or only the images which were assigned to each
of the selected categories (small selection). 

Automatic categories
 MAGIX Photo Manager 10 Deluxe can automatically assign your photos to specific categories. Select a
folder or different images and activate the "Automatically assign images to categories" in the "Edit" menu.
Images will then be analyzed for certain image content and sorted into corresponding categories (e.g.
night, sunset). 
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This function should be understood as a rough presorting feature. Not all images are always correctly
sorted, and sometimes they appear in two completely different categories. This depends on the diversity
of the photo's subject, which may be interpreted differently. 
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Database

 The "Database" area opens the MAGIX program-compatible media database. This shows all (used)
folders in which you can find your files like photos, music and videos and can also be used with future
MAGIX products. 
These folders are "Virtual database folders" with which you can manage your photos and the categories.
They display the properties according to which photos and other media files are sorted. 

Change properties
 Using Drag & Drop
 You can move complete folders by "Drag & Drop". The properties of the photos and files contained are
changed automatically. For example, you can move the folder under "Year > 2003" into the folder "Year
> 2005". This way every file's year will be changed to 2005 in the moved folder. 

Change properties
 You also have another option: Select the folder where you want to change the photo and file properties. 
Select the corresponding photos or files from the photo overview. 
Right-click on one of the selected entries to open the context menu and select "Properties". 
In the dialog displayed you can change the properties. 
After closing the dialog with "OK", the tree structure in the database is updated accordingly. 
Note:
 All changes relate solely to the "virtual database folder" and the properties of the files. The folders on the
hard disc remain unchanged! 
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Albums

 "Albums" contains all of your playable photo albums and those which you created. If you haven't opened
this view, then a mouse click on an album will load it in the center of the screen (Photo overview). 
Settings
 Photo album settings can be changed via the context menu (right mouse click) or via the "File ->
Options" menu. You can open this dialog via the keyboard shortcut "Y". 

New
: A new, empty photo album. 
Save as...
: The current photo album will be saved. 
Sort
: Depending on whether your albums should be sorted
according to name, creation date, date last modified or
length, you can determine these details here. 
Delete...
: If you no longer require an album (maybe you have placed
all of the photos in another album), then you can use this
function to delete it. 
Note
: If you delete an album, only the link to photos in the album
will be deleted. The actual photos still remain in the folders
of your PC. 
This button opens the menu, which not only contains the
functions of the buttons, but also further commands for
photo albums. 
Open...
: Opens a previously saved photo album. A file window is
opened for this purpose with which you can control the
memory folder of the photo album. 
Rename
: If you would like to give the currently selected photo album
a new name, then click here and enter a more accurate
name. 
Properties
: Here you can open a dialog which lists all of the
characteristics of the album. You can always customize these
according to your wishes. 
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File information

 Here all available information on the selected files is shown. This information is also at your disposal in
the database view under "File information". 

Page 52



Preview / Media Player

 Use the preview (Media Player) to view pictures, videos, etc. in mini format. To do so, click on the
picture in the photo overview or in the album view. Now you'll see it in the preview. You can also listen
to music files or watch videos here. Simply select them in the same way and click on the playback button
in the preview. 
If you want the view to be larger so that you can see the details of a picture, simply click on the symbol
to the far left. This opens the Slideshow Monitor
. 
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Photo overview
 Files in a selected folder display are shown with preview images in the photo overview window. 

You can select the photos and other media files in the overview window, move them to the database
folders, assign categories to them, use them in albums, and so on. 
In this section:
Buttons in general
Buttons below the overview
Show photos
Selecting photos
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Buttons in general

Search
 opens a comprehensive selection dialog box with
options for finding specific media files on your hard
drive or from within the database. 

Backwards/Forwards
: These buttons include the "Database",
"Category", "Calendar" and "My photo
albums"  - This way, you can always get
back to the last view. 

Use this button to change to My Computer
 and navigate the folder structure on your PC. 

Upwards
: This button accesses the parent folder. 

Several functions that make it easier to operate MAGIX
Photo Manager 10 Deluxe are hidden here. 
Selection aid (check boxes):
 If this function is activated, small check boxes will be
displayed to the left of the music tracks which can be used
to select the tracks. This makes multiple selections easy. 
Audio commentary
: If you have a microphone connected to your PC, then
you can record and save commentary for each of your
images. In "Display", you can set whether comments
should be shown or hidden and when they should play.
This function can be found in an images context menu and
via the "Edit" menu. 
Background color
: Do you prefer more colors? Then simply change the
design of the background in MAGIX Photo Manager 10
Deluxe to suit your tastes. Just enter whatever color you
would like for the album and photo display. 
Sort by
: This button sorts the song order. In the "detailed
information" view you can also do this by clicking on the
corresponding category at the top of the window. 
Here you can display or hide the photo album
. If you would like to have more room available for the
photo overview, then close the album view. 
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Buttons below the overview

Optimize:
 Opens the image optimization dialog box. Read
more on this topic in the "Optimize view" chapter. 

Rotation:
 The bottom of the window features two buttons for
adjusting the horizon in an image. Photos may be
rotated in either direction. 
Delete:
 Deletes the selected photos from your computer. 
The arrow buttons enable you to browse forwards or
backwards
 in the current folder. These buttons can also be used
during playback of a slideshow. 
1:1
 The current photo is shown in original size. 
Fit (image to window size):
 This option enlarges the image so that it completely
fills the slideshow monitor. 

Zoom:
 You can zoom into and out of the image to view details by adjusting the controller. 

Sharpen display: present your pictures with MAGIX
Photo Manager 10 Deluxe and even sharpen the
contrast; the original picture will not be changed in the
process. If you would like to optimize the original
picture in general, then additional functions are
available via "Optimize"
. 
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Show photos
 All the photos in a folder are shown as thumbnails in the overview window. 
Managing the view and additional functions of the photo view

 Here you can specify what should be shown in the photo view: Only the thumbnail view of the pictures,
all details of the pictures or with extra film strips, i.e. select the view you find the easiest to read. 
In addition, you'll also find the "Marker help" function, which simplifies the selection of files. When this
function is active the files can be selected by ticking the box at the top right of the corresponding file. 
File category:
 If you assign categories to your pictures as well, you can activate the function here so that the
corresponding symbol will appear beside all pictures to which a category has been assigned. This way
you always have the complete overview in MAGIX Photo Manager 10 Deluxe of which picture can be
found in which category. 

Sort by:
 You can sort your albums here according to name, date of
creation, date of modification or length. 
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Selecting photos
 Selecting all photos:
 You can select all the photos in the overview window using the Ctrl + A keys. 
Select multiple photos that are not directly behind one another:
 In MAGIX Photo Manager 10 Deluxe multiple files can be selected with a click of your mouse without
having to use your keyboard: To do so, click on the small box to the top right that appears when you
place your mouse over a picture. When you tick this, the picture will remain selected, even if you click on
another picture. 
To select multiple photos that are not positioned after one another, hold down the Ctrl key on your
keyboard click on each file you want. 
Note: It may be useful to sort the photos differently so that the desired photos are displayed one after
the other and can be selected quickly. You can find more information about this topic in the Show photos
 chapter. 
Selecting multiple photos (one after the other):
 Click on the first photo, press the Shift key on your keyboard and select the last photo while keeping the
key pressed. 
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Album view
In the program section to the right, you
can open the album view at any time if
you require it to create or edit albums. 
Here, pictures can be quickly and clearly
sorted, ideal for specifying the order of
pictures. 

In this section:
Album view buttons
Create, fill, and save a new album
Change the order of the photos
Use music
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Album view buttons
 You can open the album view on the right side of the screen at any time if you want to create or edit
albums. 

Open and close this section via the album view button. 

Press this button to open a menu to set up and save new
albums or open previously created albums. 
You may also specify how you would like to show your
pictures via the album view. 

If you save an created album you've just
made, it will be displayed as the current album
in the album view. If you select the pictures
while in photo view and click the "Add to
album" button, they will be assigned to this
album. 
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Create, fill, and save a new album
 Step 1: Open a new album

Click this button first to open the album view (in case it isn't
open yet). A new, empty album will be created. 

Step 2: Fill the album with pictures
 There are 3 options for assigning images to an album: 
A)
 Simply select the pictures from the photo overview that you want to add to the album, and then drag
them into the album view. 
B)
 Select an image and press "S" on the keyboard. 

C)
 The currently selected photos can be assigned
to the open album by clicking this button. 

Step 3: Save the album
To save the album, click this button again and then select
"Save album..." 

Specify where you wish to save your slideshow on your PC and what it should be named. 
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Change the order of the photos
 You can easily change the order of the slideshow via drag & drop. You can choose multiple photos by
pressing down the Shift or Ctrl keys on the keyboard so as to move photos together. 
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Use music
 Should you need a soundtrack for your slideshow you can drag an audio file, just like a photo, from the
overview window into the slideshow. Depending on the length of your slideshow, you can add a number
of different music tracks as a slideshow soundtrack. The first music track will be played first. 
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Optimize view
The easiest way to open the optimize view is via
the "Optimize" button (in the bottom portion of
the photo overview
) or in the "Edit" menu 

All changes will be displayed in real time, and the original image will not be overwritten, provided you
have the "Non-destructive" button active. So go ahead and experiment until you have results that are
pleasing - your precious original will remain the same. All effect settings are saved as separate files with
the extension *.jpx. 
If you would like to calculate your changes into the original image, then click on "Fix effects". This will
overwrite the original image and these optimization steps will not be able to be undone. 
Note
: Edit a digital photo which contains a EXIF image information and this information will be preserved if
you save the optimization effects. 
In this section:
Buttons
Non-destructive and destructive work
Basic functions
Advanced functions
Edit image externally
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Buttons
Effects active: 
Switch global optimizations on or off here. This
way you can compare the result with the initial
state. 
Non-destructive FX: 
Deactivate this function, if you would like your
optimizations to be applied immediately. If it
remains, then you can always undo the effects
of your work. 
Clicking on this button opens the slideshow
monitor for viewing your pictures. 
To leave the optimization view, either click on
the optimize button a second time or simply on
the X. 
Undo/Restore: 
These buttons allow you to undo or redo
individual effects. Even if a different photo has
been selected in the mean time, MAGIX Photo
Manager 10 Deluxe remembers the order in
which the effects were used. 
Undo all: 
This button allows you to set all previous
settings in the optimize view to neutral values. 
Set effects:
 The effects that are set up are saved in the
photo and cannot be undone at a later stage. 
Apply to all:
 With this button you can apply the current
settings to all pictures in the current folder.
After clicking on this button a preview window
with all the picture files of the folder opens.
You can choose if each picture file should use
the current settings that are in use in the
optimize view. 

Here you can use the presets for
editing your pictures. These are
included as part of the program and
are perfect for typical image errors,
but they can also be created
individually. 
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Non-destructive and destructive work
 Besides the purely non-destructive application of effects, it is now possible to switch between
non-destructive and destructive mode for image files. In destructive mode, all changes made will be
applied directly to the original image file. This often makes it easier to use such files in other programs or
to transfer them to third-party programs. 

1:
 Check this filed to activate non-destructive editing. This allows effects to be undone. 
2.
 Remove the check for "Effects active" to view the original image. This makes a fast comparison between
the original and the edited images possible. 
3:
If you would like to fix the effects to burn edited images, etc., then click here. The original file will be
overwritten and cannot be restored. 
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Basic functions

 Auto-exposure
 These options use automatic exposure correction. 
Auto-color
 These options use automatic correction of the color ratios, that is, all color channels (red/green/blue) are
brought to optimal brightness. You can achieve the best results with photos that have lots of colors. 
Photos with intended discolorations (for example, sunsets) become grey very quickly. In these cases you
should use "White balance" or "Auto exposure". 
Tip:
 These settings can be used well in conjunction with the "Picture view" option. At best you should select a
section with a relatively homogeneous coloring, for example, the sky. Then select the option "Auto color"
and click on "Reset picture clip". If you don't like the result, you can always revert to the previous state
using "Reset". This method leads to amazingly creative results. 
Brightness
 You can select various types of brightness settings with the fader. However, only one is possible at a
time. 

 Gamma: This method sets the brightness of the areas that can be discerned by the human eye.
This is advantageous insofar as shadows remain dark (as opposed to turning gray) when
brightening up photos, and that very bright areas are not influenced when darkening an area.

 Shadows/Mid tones/Lights: This brightens up/darkens shadows, mid tones and lights. If, for
example, you wish to darken shadows, but want to leave the other bright areas as they are
(unedited), moving the "Shadow" fader to the left offers the best results.

 Linear: This is the "normal" brightness setting. The photo is brightened/darkened uniformly.
Tip:
 Nearly all photos can be improved by a minor gamma correction. Low values create darker, warmer
colors; higher values lighten up shadows. 
Contrast
 Low contrast values whiten photos and remove exaggerated contrasts in brightness. Higher values
increase the brightness contrasts and can, if overused, distort the photo. 
Focus
 You can set the focus of the picture using the sliders. If the focus is increased, basically an enhancement
of the edges or structures will result. When lowered, a blurring effect is used. 
Red eyes
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 Use this button to automatically correct red eyes with a click of your mouse. 
You can also adjust red eyes manually. There are various paintbrush sizes available for this: Move the
mouse pointer to the middle of the red eye. Move the paintbrush into the desired size by holding down
the left mouse button. 
Now you can retouch red eyes at the relevant points. At this point a preview is helpful. Should the effect
be too weak, you can click on the eye repeatedly to increase the effect. 
Tip:
 Using the mouse wheel you can zoom in and out of the photo. Here, you can zoom into the area where
the cursor is. This way, you can make corrections much more precisely. 
Crop image
 You can use this option to crop the image by holding down the left mouse button. To use the cropped
image (instead of the whole picture), click on "Set". You can revert the setting to its original state using
the "Reset" button, that is, you can view the complete picture once again. 
Straighten horizon
 This button lets you straighten crooked pictures. Simply draw a line using the mouse along the crooked
horizon. The picture will be rotated automatically so the horizon line runs horizontally. The sides will be
clipped. 
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Advanced functions

 White balance
 Pictures, for example, of clouds or snow, often contain color faults. You can use this option to carry out
manual white balance. This means that white areas become really white. After activation, use your mouse
to select a small area in the picture that should be completely white in reality. All areas in the picture will
then be adapted to the color automatically. 
Color in...
: 

Click "Color in..." to open a small dialog: In the color field, you can adjust the complete coloration of the
picture, e.g. to remove a blue tint. "Reset" reverts the point in the color field back to its neutral setting. 
Black/White
 Click to make color pictures black & white. 
Sepia tone
 Transforms color photos into black and white photos and adds yellow to the picture to give the
impression that it's on old paper. 
Saturation
 With saturation you can shift the intensity of the colors. If a picture is particularly color-intense in
comparison to the original, you can correct this effect with the saturation fader. 
Color temperature
 This slider may be used to correct the color effect to make the subject appear in real color, i.e. without
any color distortion. Use the slider to shift the portions. 
Text in picture
 Enter a caption for the image here. If the text exceeds the image's borders, then the font size will adjust
so that the amount of text will fit on a single line. 
Click on the text with the mouse cursor and move it by clicking it with the left mouse button to the
position you want on the image. 
Text commentary options
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: 
 Font name, size, color: With this button you can access the selection dialog for the font size and

style. The "Color" button accesses the selection dialog for the font's color.
 Shadow: In this section you can insert shadowing on the lettering and set the size of the shadow

(offset). Use "Color" to adjust the color of the shadow.
 Background: In order to make the text more easily readable, it may be necessary to place a

color-filled frame behind the text. This makes it easier to see.
 Scrolling text: Activate this option and the text will be shown as scrolling text (if it is long

enough). In any case, the text will not be present during exporting or printing.
 Image comments: Enter the desired text here.

Curved lines
 This function may be used to correct curved lines in pictures resulting from perspective distortions.
"Curved lines" are lines and edges, which run together in an image, although they are parallel to each
other in reality. 
Select the corresponding image and click "Curved lines". Calculation will begin and a copy of the image
will be produced without curved lines. 
Pan
 Click here if a panorama should run from left to right in fullscreen. The panorama will no longer be
shown in full width, but rather panning from the left to the right. This feature must be set for each
panorama individually. 
If a particular panorama should not be played back in this manner, then remove the check mark from
"Options -> Camera pan" again. 
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Edit image externally
 You can select different tasks in the "Edit image externally" tab. The "Photo Clinic" button opens the
current image in MAGIX Photo Designer, which then performs the selected tasks. 
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Slideshow monitor
 The slideshow monitor can be opened in the overview by double-clicking on a photo. Here you can run
your slideshow in "large format" and it's possible to make further adjustments using the "Edit menu". 

In this section:
Menus in the slideshow monitor
Keyboard shortcuts
Slideshow context menu
Slideshow monitor buttons

Page 72



Menus in the slideshow monitor

 File
 Save photo as...:
 The photo will be saved under the name you enter. 
Export photo...:
 The photo will be exported. You can find out more about the export dialog in the "Export: Export photo
album" chapter. 
Keyboard shortcut: Ctrl + E 
Copy photo:
 The displayed photo will be saved as a graphic into the clipboard. This way you can use it in every
program that can import (via "Insert") from the clipboard. 
Close slideshow monitor:
 Close the large view of your images and return to MAGIX Photo Manager 10 Deluxe's main interface. 
Keyboard shortcut: V 

Edit
 Here you'll find lots of commands from the optimize view that can be used to spice up your photos. 
Note:
 None of the available effects change the original photo on your hard disk. They are calculated again each
time the files are accessed so that the settings can be undone every time. 

View
 Here you can access various settings for the slideshow view sizes. If you are not satisfied with the
dimensions provided, then select "user defined" and enter the measurements you desire. 
Slideshow options:
 You can specify how long the selected photo is displayed and what the transition to the next photo
should be, if you so desire. 
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Keyboard shortcuts
 File menu 
Export photo Ctrl + E 
Close slideshow monitor V 
Edit menu / Context menu 
Reset all effects Shift + F 
Rotate 90° clockwise # 
Increase contrast P 
Reduce contrast O 
Increase brightness = 
Sharpen picture Ctrl + H 
Soften picture Ctrl + G 
Increase saturation Ctrl + W 
Reduce saturation Ctrl + Q 
Increase color temperature Ctrl + = 
Reduce color temperature Ctrl + + 
Sepia tone Shift + S 
Black & White Ctrl + B 
White balance Shift + W 
Straighten horizon H 
Remove red eye R 
Crop current selection W 
Optimize Shift + V 
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Slideshow context menu
 Close slideshow monitor:
 Close the large view of your images and return to MAGIX Photo Manager 10 Deluxe's main interface. 
Keyboard shortcut: V 
Next/Previous image:
Change to the next or previous image in your slideshow or open folder. 
Leaf per mouseclick:
 If this function is active (check mark displayed to the left), then you can change to the next image by
clicking the left mouse button or change to the previous with the right mouse button. If you would like to
deactivate this function, then hold the right mouse button down, circle over the function with the mouse
cursor and release the mouse button. 
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Slideshow monitor buttons

Rotation: Use these buttons to turn your images.
Portrait images may also be set properly with this
function. 
Arrow buttons:
 Flip forwards and backwards within the selected
folder using these buttons. These functions can also be
used during playback of a slideshow. 

Start/Stop:
 Starts/stops playback of the slideshow. 
1:1:
 The current photo is shown in original size. 
Fit:
 (Fit image to window) This option enlarges the image so
that it completely fills the monitor. 
Display options:
Open this menu to adjust settings like the display time and
duration of transitions. The type of transition can also be set. 

View duration

 Use the slider to adjust the display time of a photo during slideshow playback without having to open the
dialog. 
Zoom

 Use these buttons and the slider to zoom in and out of the picture. If your mouse has a scroll wheel, this
can also be used to zoom. 
You can move the picture with your mouse in a zoomed-in picture. To do so, click on the picture and
simply move the picture while holding down the left mouse button. The buttons on the edges can be used
to access a small menu featuring different zoom stages (1:1, 1:2, etc.). 
Sharpen display

Present your pictures with MAGIX Photo Manager 10
Deluxe and even sharpen the contrast; the original picture
will not be changed in the process. If you would like to
optimize the original picture in general, then additional
functions are available via "Optimize". 

Fullscreen mode
 You can display the picture in fullscreen by clicking the "Maximize" button in the top right. Move the
mouse between the upper or lower borders of the screen in fullscreen mode; this will make the buttons
reappear. 
Flip through the photos in the folder using the arrow keys. Clicking the fullscreen symbol takes you back
to the normal view. 
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Keyboard shortcuts
 File menu 
Open photo album Ctrl (right) + O 
Save photo album Ctrl+S 
New folder F7 
Options Y 
Quit Alt+F4 
Edit menu / Context menu 
Select all Ctrl+A 
Cut Ctrl+X 
Copy Ctrl+C 
Insert Ctrl+V 
Move to Recycle Bin Del 
Delete permanently Shift + Del 
Rename N 
Copy into folder Ctrl+M 
Optimize Photo Shift + V 
Hide Alt+Delete 
Clear Shift + Del / Del 
Start slideshow B 
Windows menu 
Slideshow monitor V 
Help menu 
Help F1 
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More useful functions
In this chapter
Database
Import
Create slideshow
Export
Secure data: Burn
Find pictures and make a selection
Print and order pictures
Create map
Create panorama image
MAGIX Media Viewer
Adjust properties
Equalizer

Page 78



Database
 With MAGIX Photo Manager 10 Deluxe, you can create a Database of all of your data. In this way,
you can quickly and easily access all of your target files and edit them as you wish, arrange your photo
albums, and much, much more. 
To add a Database
, proceed as follows: 

 Either press the "Import" button and select "Folder", or 
 Proceed to the menu item "Database -> Add folder".

Note! The Database is actually composed of paths to the original files. The files remain at their original
positions, and no copies are produced. If you launch a file via the Database, then you are not opening a
copy, but rather the original
 file via the link! 
If you want to search a very large Database for a specific file
, then this is also possible. 

 Press either the "Search" button or 
 search via the menu item "Database -> Search Database..."

If you work a lot with MAGIX Photo Manager 10 Deluxe and frequently add to or delete data in the
Database, then it is possible that the Database contains old data links, causing it to become outdated. To
update it, simply use the "Optimize database "function in the "Database" menu. 
Additional database functions can be found in the "Database
" chapter. 
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Import
 There are multiple options available to you for importing your data into MAGIX Photo Manager 10
Deluxe. Select the correct button for the desired import method. 

In this section:
Import from external devices
Import from your MAGIX Online Album
Add folder to the database
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Import from external devices
 In MAGIX Photo Manager 10 Deluxe you will find an easy to operate dialog for transferring your data
over to your computer. 

Connect the device to your computer, and MAGIX Photo Manager 10 Deluxe will recognise it and ask
you if you would like to open the import dialog, since you probably want to import files. 

You can also open this dialog
via the "Import" button. 

You can switch between
advanced and beginner modes
with this button (nr. 1 in the
diagram). 

Note
: When connecting external devices (e.g. mobile telephones, USB sticks, etc.), it's possible that these
devices must first be recognized by your computer. Once your computer recognizes the device, MAGIX
Photo Manager 10 Deluxe can access it. If display of the device is problematic, then please refer to the
product's manual or contact the manufacturer. 

Additional import functions
 Click on "advanced" and the following additional functions are made available: 
View buttons (nr. 3
 in the diagram) 

If you would like to delete the images from the
connected device, then select them and click
"delete". 
Determine what the display sequence of the
files should be: name, type, date of creation,
etc. 
Define which files should be displayed. For
example, if you are looking for all of the files
from a specific day, then the list view is often
enough. 
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Additional saving and importing functions (nr. 2
 in the diagram) 
New name:
If you would like to save your files in a subfolder when you import, you can define it here. 
File name:
 Define how imported files should be titled. If you do not apply any changes, then they will remain titled
as they are on the connected device. 
Add to photo album:
 Imported files can be assigned directly to existing photos albums. Enter the respective album here, if this
is the case. This can save you time. 
Import settings
 Delete imported photos from the camera:
 All the files that you have imported with MAGIX Photo Manager 10 Deluxe can be deleted from the
connected device. Just bear in mind that they cannot be recovered from the device once they have been
deleted... 
Convert photos on import:
 You can edit photos as you import them. 
Image qualities
: Click here and a small dialog will open for you to add information such as author and category (new
categories can be added). In addition, you can choose whether the EXIF creation date should be
ignored, or if the photos should show the original EXIF date. If this is ignored, then the date of import will
be defined as the creation date. 
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Import from your MAGIX Online Album
 If you would like to load media from your MAGIX Online Album to your computer, then proceed as
follows: 

Step 1:
 Click the "Online Album" button. 

Step 2: Switch to the "Manage" screen and log in.
The dialog for managing your MAGIX Online Album will open. 
Step 3: Go the album/folder which contains the media that you want to copy to your hard disk.
All media in the album will be displayed. 
Step 4:
 Under "Save downloaded media in", enter the folder on your hard drive where the media should be
copied. 

If you only want to copy a few files
from the Online Album, then select
these and click "Download selected". 
If you want to copy all of the media,
then select "Download all". 
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Add folder to the database
 MAGIX Photo Manager 10 Deluxe can add a specific folder on your computer to the database via the
following options: 
A)
 Click "My Computer" and navigate to the folder and MAGIX Photo Manager 10 Deluxe will
automatically add the files to the database. 
B)
 Use the "Add folder" function in the "Database" menu. The import dialog will open. 

C)
 Click the "Import" button and switch to the "Folder"
screen. 
The import dialog will open. 

Note!
 The database is only composed of paths to the original files. The files remain at their original positions,
and no copies are produced. If you launch a file via the database, then you are not opening a copy, but
rather the original file! 
In this section:
Database import dialog
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Database import dialog

1.
 Enter the folder which contains the data which should be
added to the Database. 
2.
 "Close subfolders" is normally active (checked off) so that all
folders included which contain images will also be transferred
to the Database . 
3.
 "Permanently monitor" is also normally active. So that a
folder is always in the most up-to-date condition, it can be
monitored permanently by MAGIX Photo Manager 10
Deluxe, and changes to the folder will be reflected within the
Database. 
4.
 Click "Add folder to the database" to start the import
process. 
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Create slideshow
1.  Select the picture and video files (if applicable) that you would like to use to create the

slideshow, and then click "Export" on the toolbar.
2. In the dialog which opens, select "Create slideshows and videos from file(s) (YouTube upload,

etc.)" in "Photos & videos", and then press "OK".
3. Activate the desired format. The dialog for creating the slideshow will open.

Possible formats
: 

 WMV
 MXV
 AVI
 RM
 MOV

In this section:
Start
Load files
Style
Music
Presto!
Export dialog
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Start
You can enter the
name of your
slideshow here. This
name will be used as
a preset title for the
slideshow to be
created. 
Specify the aspect
ratio for the
slideshow. 

Cut to fill monitor automatically: This determines how MAGIX Photo Manager 10 Deluxe behaves with
photos that do not match the slideshow's format. Images that do not correspond to the slideshow's
aspect ratio are adjusted automatically. The zoom factor is set in such a way that there are no black bars
to the left or right or top to bottom. 
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Load files
"Load file(s)..."
allows you to select
photos and videos
for integration in the
slideshow. 
"Delete selection"
removes the selected
photos and videos
from the list. 
The sequence of
photos can be
specified via drag &
drop. 
Turn images 90°
: The selected photos can be rotated 90° clockwise with this function. To turn a photo 90° to the left, this
button must be clicked three times. 
Display time for each photo (seconds)
: By default, photos are displayed for the time entered here. 
Total length of slideshow
: The approximate total length of the slideshow created is shown here. It adjusts to reflect any changes
that are made. 
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Style
Simply select one of
the styles that best
suits the theme of
your slideshow. If
you don't want any
effects, then select
the entry marked
"No effects". 
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Music
You can select
between the
suggested pieces of
music or one of your
own by importing it
into the list via "Load
file(s)". If the
slideshow is long
enough, then all of
the pieces contained
in the list will be
loaded into the photo
one after the other. 
The sequence of songs can be specified via drag & drop. 
Preview
: This button provides a preview of the selected song. 
Remove selection
: This deletes the selected song from the list. 
To the right in the dialog, you can see the total length of the background music and of the slideshow. This
enables you to see if other music tracks need to be loaded, e.g. the slideshow is longer than the music,
and you don't want to repeat the music. 
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Presto!
 In case you select WMV, MXV, etc., you will see the following options for exporting
: 

Exports the arrangement in the
corresponding format and
adds it to your video folder. 

In case you select YouTube upload, you will see the following options for exporting
: 

You can upload the slideshow
you created to YouTube™
directly from within MAGIX
Photo Manager 10 Deluxe. 

The command opens a dialog for you to set the name of the slideshow for YouTube (default is the same
as in MAGIX Photo Manager 10 Deluxe), description, keywords (so-called "tags"), and the category for
the video. You may also indicate whether the video should be private or public.
After confirming your entry by pressing "OK", the slideshow will be exported and uploaded to
YouTube™. This is why you have to enter your YouTube™ account access data (username, etc.) to
connect to YouTube™. If you don't have an account, open your browser and go to YouTube™ to sign
up for an account first. 
If uploading was successful, your browser will open the info page for the video you just uploaded to
YouTube™ to double check your description and tags. If everything looks correct, just leave this page
and the new video is already listed under your videos. YouTube™ takes some time to process the video
for online presentation, but after this period, the target group you have specified will be able to watch it. 

Page 91



Export dialog
 You can export your slideshow in various video formats. The options available vary according to the
selected format. 
Export settings
 Presets: These are the typical settings for the selected format and the most important applications. 

You can save your settings by pressing the "Save"
button and remove them by pressing "Delete". 

This includes general export parameters like resolution, page proportions, and frame rate. Select the most
frequently used values from the list fields; to set your own values click on the "..." button. 
The "Advanced" button opens the specific settings for the selected video format. 
"File" enables you to export your file to another folder than the preset one. "Overwrite file without
confirmation" enables you to execute multiple exports of the same file. 
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Export
 In the export dialog you can choose from four different areas: "Photos & videos", "MAGIX Online
Album", "Creative", and "Forward". 
Once you have customized your export settings in one of the areas, MAGIX Photo Manager 10 Deluxe
will remember these settings and will load them again the next time the program is restarted in a specific
area. You can, of course, make modifications at any time to meet your requirements. The saving function
is there to make your life easier, e.g. if you want to create the same video formats while using the same
settings. 
A general introduction is available in "Present photos
". 
In this section:
Export files one by one
Create slideshows and videos from file(s)
MAGIX Online Album
Creative
Forwarding
Additional export functions
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Export files one by one
 This option provides different ways of saving images or videos as files. 
Advanced settings
 Adjust size: 
This option converts the photos into the selected target format defined in "Export options". 
Shrink/stretch all photos to target size: 
This option converts all photos to the defined "target size". 
Only shrink large images to the target size:
 This option reduces larger images as set in "target format"; smaller images remain small. This way no
artifacts are created by enlarging smaller images. 
Target format
 This lets you choose a format for conversion. "More options" opens the quality settings of the respective
format. 
More options ? Quality: 
This defines the size of the exported photos. 
Effects
 No picture effects:
 This option deactivates the optimize view settings. 
Copy effect description file:
 All effect settings are saved from the optimize view as separate files with the extension *.jpx. When using
this option, the file will also be copied to the target folder. 
Render effects into pictures: 
If this setting is activated, the effects from the optimize view are included in the files. "Master Gamma"
also includes the global brightness setting; "Write comment into image" includes the subtitles. 
In this section:
Export dialog for individual files
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Export dialog for individual files
 Target folder
: Enter the folder where you would like to store your photos. 
Change/Don't change file name
: Lets you keep the original title names or assign a new name. All photos in a photo album are given the
same name and numbered consecutively. 
Overwrite existing files in target folder
: If you have copied certain files into the same target folder and then repeat this process, then this process
will overwrite the old file versions with the new ones. 
Export options
 Select how you would like to export. Depending on the method, the quality of the saved file will be
adjusted accordingly (small = poor quality, large = improved quality). To the right of the export options,
you can see the info text and the selected image size. 
Copy originals
: This option only copies the photos in the folder specified without editing them. 
Additional profiles
: Besides the main export options, you can see other options are available for exporting your files and
adjusting their size. 
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Create slideshows and videos from file(s)
 If you want to create a slideshow from a number of files and have selected which type of video (video
format) you want to create, open the "Create slideshow
" dialog. You can apply settings step-by-step for professionally transforming your images into a
slideshow. 
The convenient YouTube
 upload feature is also located here. Select "YouTube upload" in the format dialog. 
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MAGIX Online Album
 Send selected media to your Online Album
: Log in to the MAGIX Online Album service and load your images into the album you want to show
them to your friends and acquaintances in the Internet. The assistant will lead you step-by-step through
the uploading process. After the process is finished, you can access your updated album online. 
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Creative
In this section:
Create and install screensaver
Create and install desktop background
Create calendar-based desktop background
Create a self-executing slideshow
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Create and install screensaver
 So, you really enjoyed your slideshow? Then why not set up the arrangement as a screensaver? To do
this, click on the "Export" button and select "Export slideshow as screensaver" ? and voilá! ? your
slideshow is flickering away on your monitor during rest pauses. Any audio material in the slideshow will
not be considered for export. 
For a screensaver that you can actually watch, most pictures have to be adapted to a format suitable for
screensavers. The following dialog opens in this case: 

As standard, the size is set to 800 x 600, an aspect ratio of 4:3 is set. You can customize the sizes if you
like. 
By clicking on "OK" the export process will start. Once the screensaver is complete it will be installed on
your system automatically. 
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Create and install desktop background
 This option exports the images as a desktop background. Helpful, if you just can't decide on a favorite
picture. 
Audio material from the slideshow that may be available will not be considered. The desktop background
is then installed in the system and played back as an endless loop. 
The pictures usually have to be adapted for export : As standard, the size is set to 800 x 600, an aspect
ratio of 4:3 is set. You can customize the sizes if you like. By clicking on "OK" the export process will
start. 
After setting up the desktop background it will be installed on the system when you place a tick beside
the "Install on this computer" option in the dialog that appears. 
Under "Effects" you can set which effects should be used and if the change should always occur as a
transition or with a random effect. 
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Create calendar-based desktop background
 This option exports the images as a desktop background. Helpful, if you just can't decide on a favorite
picture. 
Audio material from the slideshow that may be available will not be considered. The desktop background
is then installed in the system and played back as an endless loop. 
The pictures usually have to be adapted for export : As standard, the size is set to 800 x 600, an aspect
ratio of 4:3 is set. You can customize the sizes if you like. By clicking on "OK" the export process will
start. 
After setting up the desktop background it will be installed on the system when you place a tick beside
the "Install on this computer" option in the dialog that appears. 
With Windows versions before XP, you can deactivate this desktop background again by going to
"Control Panel" > "Display" > Internet Options" and deactivating the function "Active desktop". 
Under Windows XP you can proceed as follows: Control Panel > Display > Desktop. Here simply
select a new background from "Background". 

Create a self-executing slideshow
 This option exports the photo album as an *.exe file, which can be automatically played back on any PC
by double clicking it. 
This way, you can be sure that the file can be started and played, regardless of video format or any
codec that may be required. 
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Create a self-executing slideshow
 This option exports the photo album as an *.exe file, which can be automatically played back on any PC
by double clicking it. 
This way, you can be sure that the file can be started and played, regardless of video format or any
codec that may be required. 
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Forwarding
In this section:
Export to mobile device...
Sending photos via email
Photos as ZIP
Send photos via e-mail as a ZIP
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Export to mobile device...
 The selected photos or content of the selected photo album can be exported to your mobile device with
this option. 
This option opens the dialog for exporting files to a mobile device. Here you can select your camera,
removable device or infrared/Bluetooth-enabled device. If supported by the respective device, you can
enter a direct path to the target device. 
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Sending photos via email
 This option exports the slideshow or individual pictures and then attaches them to an opened email. 
All you have to do is enter the address and the subject matter, and click on "Send". 
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Photos as ZIP
 Photos at high resolutions are correspondingly large. To save on memory space or to reduce the size of
larger photo files, it's recommended that you zip photos: If you create a zip file from one or more photos,
corresponding zip file will be smaller than the original. 
Once the zip file is unzipped, the photos will appear in their original sizes again. 
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Send photos via e-mail as a ZIP
 To save on memory space or to reduce the size of larger photo files, it's recommended that you zip
photos: If you create a zip file from one or more photos, the corresponding zip file will be smaller than the
original. Once the zip file is unzipped, the photos will appear in their original sizes again. 
Use this function, if you would like to continue and send the ZIP via e-mail. You can make the necessary
steps one at a time in MAGIX Photo Manager 10 Deluxe. 
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Additional export functions
 Advanced settings
 Adjust size: 
This option converts the photos into the selected target format defined in "Export options". 
Shrink/stretch all photos to target size: 
This option converts all photos to the defined "target size". 
Only shrink large images to the target size:
 This option reduces larger images as set in "target format"; smaller images remain small. This way no
artifacts are created by enlarging smaller images. 
Target format
 This lets you choose a format for conversion. "More options" opens the quality settings of the respective
format. 
More options ? Quality: 
This defines the size of the exported photos. 
Effects
 No picture effects:
 This option deactivates the optimize view settings. 
Copy effect description file:
 All effect settings are saved from the optimize view as separate files with the extension *.jpx. When using
this option, the file will also be copied to the target folder. 
Render effects into pictures: 
If this setting is activated, the effects from the optimize view are included in the files. "Master Gamma"
also includes the global brightness setting; "Write comment into image" includes the subtitles. 
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Secure data: Burn

 CD/DVD:
 Click here if you wish to create backups of your photos. You can specify whether you wish to create a
CD or DVD in the "MAGIX Goya burnR" burn program. 
Slideshow:
 Select this burning process if you wish to burn copies of individual photos which will then shown
automatically when you insert the CD/DVD into the drive. An autostart-enabled CD/DVD drive is
required for this to work. 
WMV HD:
 To play your movies at optimum quality on your PC, select WMV HD. Microsoft MediaPlayer 9 or
higher must be installed for this to work. 
JPEG disc:
 This burning method creates an autostart-enabled JPEG disc, which can be played at very high quality
via your DVD player on your TV. Your DVD player must have JPEG disc compatibility for this to
work. 
Hint: For a detailed explanation of the burning process, please use the program Help from MAGIX
Goya burnR: pressing F1 opens the Help section.
In This Section
Burning data
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Burning data

1
. Once you've compiled a playlist that you
would like to burn as a data CD/DVD, simply
click "Burn". The burning dialog will open. 

2
. Select either CD or DVD in the
burning dialog. 

Note
: The burning process for simple data CDs or DVDs opens the MAGIX MAGIX Speed burnR burning
dialog. For detailed information about the burning program, please refer to the program's help file by
pressing "F1". 
A short overview
: 
The first step always opens the MAGIX MAGIX Speed burnR burning program. On the left side of the
burn dialog, you can navigate through your computer's folders, while on the right side of the dialog, you
can view the current burn configuration. 

 If you have changed your mind about burning the files, select the ones you want to remove and
press "Del". 

 You can also add additional files by selecting the corresponding files in the left window and
adding them to the burn list via drag & drop.

When you have compiled the contents of your future disc, click "Next". 
This dialog specifies the burn speed and sets burn options to be included in the process. When selecting
the burn speed, please remember that older burners can sometimes cause problems if a faster burning
speed is selected; media burned at a higher speed can fail to be read properly on drives that do not
support higher speeds. 
Begin the burn process here by clicking "Start burning". 
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Find pictures and make a selection
Click on this button to open the search dialog for
files and folders. The following options are
available: "Find similar pictures", "Search the
database, "Search the hard drive", "Search
according to EXIF content". 
You can also click "Selection" in the toolbar to
choose between "Create representative selection",
"Recognize faces on pictures", and "Find similar
pictures". 

In this section:
Search for similar photos
Search the database
Search on hard disk
Search for EXIF content
Recognize faces on pictures (FaceID™)
Automatic photo selection
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Search for similar photos
 Before opening the search dialog for similar photos, you must select a photo as a source for your search.
The easiest way to do so is to right- lick on the desired photo. Select "Search for similar photo
" in the context menu. 
Search for
 Duplicate search
: Have you added a copy of a photo and don't know where you have stored it? Use this function to
locate it. 
Similarity search
: If you would like to find similar subjects, then use this function. 
Search the database
 Specify where MAGIX Photo Manager 10 Deluxe should search or for photos that were taken during
specified dates. This lets you fine-tune the search, saving you a lot of time. 
Results
 Max. results:
 Specify how many results appear on a page. 
List results:
 Found photos are listed in the photo overview. 
Insert results into the photo album:
 Found photos are added to the end of the current photo album. 
Search for the first results in the photo overview (F3 key for the next ones)
: You can flip through the results in Explorer by pressing the F3 key. 
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Search the database
 Instead of clicking through individual folders in the library views, you can also search through the whole
library according to specific criteria. 
Quick search:
 Enter your keywords for a quick search (e.g. artist's last name, etc.). Remove the checks next to audio
files, photos, or videos if these types of files shouldn't be included in the search. 
'Clicking "Start search" at the bottom of the dialog will begin searching the Database using your search
criteria; relevant files will be listed. 
Expert search
 Limits search parameters. The characteristics that are to be searched for (album, year of release, genre,
artist, etc.) are listed in the column to the left. You can also specify the conditions of the search as well. 
Up to three details can be searched for at the same time by using the "AND" or "OR" logical operators. 

 "AND" means that only those files that match all criteria will be listed,
 "OR" means that only those files that match at least one of the criteria will be listed.

Results
 Max. results:
 Specify how many results appear on a page. 
List results:
 Found photos are listed in the photo overview. 
Insert results into the photo album:
 Found photos are added to the end of the current photo album. 
Search for the first results in the photo overview (F3 key for the next ones)
: You can flip through the results in Explorer by pressing the F3 key. 
Hint:
 The current photo album may also be empty! 
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Search on hard disk
 If a media file should disappear from your Database, you can use the search dialog on the second tab to
search your hard disk for the file. You can use the file date or size as the criteria for the search. 
Search for:
 Enter the search term or file extension (For example, *.jpg) for which you are looking. 
Search in:
 Set the range for the search: if a specific folder on the hard drive should be searched, click on the small
folder symbol and click to the target folder. If a folder, where the search should be conducted, contains
other folders that should also be searched, then activate the "Include folders" function. 
Date:
 You can also search according to date, like "during the last few days/weeks", or within a certain time
period. In addition you can add the kind of changes the file has gone through: was the file "created",
"changed" or simply "accessed"? 
File size ? "bigger than", "smaller than":
 Using these two search limiting functions, you can enter minimum/maximum size. 
Results
 Max. results:
 Specify how many results appear on a page. 
List results:
 Found photos are listed in the photo overview. 
Insert results into the photo album:
 Found photos are added to the end of the current photo album. 
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Search for EXIF content
 Alongside the base picture information the EXIF format also contains additional information on special
camera data, for example, date or time of recording, focal width, etc. This information is saved in the
form of tags or so-called "fields". 
Search for
 Enter the search term here and specify which fields should be searched - either in all or only in specific
fields that are determined via "Search in the following fields:
". 
Search in
 Limit the folders which should be searched - either all or only specific folders that are determined under "
Folders:
". 
Results
 Max. results:
 Specify how many results appear on a page. 
List results:
 Found photos are listed in the photo overview. 
Insert results into the photo album:
 Found photos are added to the end of the current photo album. 
Search for the first results in the photo overview (F3 key for the next ones):
 You can go through the results in Explorer by pressing the F3 key. 
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Recognize faces on pictures (FaceID™)
 A different way to catalogue pictures is by using FaceID, a development of the Fraunhofer Institute.
FaceID recognizes faces on photos and gradually learns recurring faces using typical features, and these
are then assigned to specific people. At the start, you can help FaceID with the recognition process, but
later on, you'll be surprised at just how well FaceID can recognize faces again. 
Step 1:
 Open a photo folder in MAGIX Photo Manager 10 Deluxe and select "Edit > Find similar photos >
Identify faces on photos". 

Proceed as follows to create a list of people:
 Step 2:
 FaceID circles sections on your photos that have been recognized as faces. If a face that you find
relevant is displayed, then you can give this face a name. All people will be shown to the right within the
window. 

 Set a new person: Click the "New person" button. A dialog appears (see figure) for you to
specify a name and an icon for the new person that should appear in the list. Clicking "OK" finally
adds this person to the list. 

 Remove wrongly recognized sections: If FaceID incorrectly identifies a section of the picture
as a face, select "Ignore".

Use "Previous picture" and "Next picture" to move forwards and back through the pictures. 
 Find faces manually: If FaceID doesn't supply a frame even if there is a face on the photo, you

will have to select the face yourself. To do so, simply drag out a rough frame over the face with
your mouse and give the face a name.

Step 2:
 If you have already added a few people, FaceID will suggest one of these faces for every other face
which can be assigned to this face via "Assign name". Don't worry if FaceID gets it wrong a few times at
the start; it's a difficult learning curve for such a young piece of software. That's why you will often have
to make corrections and add the appropriate name by clicking on the proper person in the list on the right
side. 
Step 3:
 After systematically searching through a folder for faces and identifying everyone, close the identification
dialog. 

 Finding the assigned pictures again: Your collection of people will continue to grow and
grow in the "Categories" area as you add more names. Clicking on one of these names will open
all pictures that show this person or have been assigned to this person.
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Automatic photo selection

 Photo selection:
 Depending on the condition of the picture, MAGIX Photo Manager 10 Deluxe should be able to create
a representative selection according to your specifications in "Search in", and you will see the number of
pictures that are available. The slider allows you to determine how many images should be included in the
selection. 
Search in:
 Specify which photos should be searched for the selection. The creation of a selection doesn't take much
time if the pictures are already in the database. 

 In all photos: All photos that are contained in the database will be included in the selection. 
 In current folder: This displays and searches the folder that you have selected in MAGIX Photo

Manager 10 Deluxe's folder view. 
 In the following folder: Enter a folder on the hard drive that has already been recorded and listed

in the database.
 During period: Limit the amount of pictures for the selection by specifying the date they were

taken. In this case, only pictures will be considered that are already recorded in the database.
Selection criteria:
 Specify the criteria used to create a selection. The more criteria are activated, the better the selection
results will be. 
Image analysis:
 Activated image analysis functions cause selection to take a little longer, but the results are more
representative. 
Click the "Create selection" button once you have specified all the criteria. MAGIX Photo Manager 10
Deluxe will then create your selection as a new album for you to adjust and then save. 
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Print and order pictures 
If you want to print your images at home or order prints online from our Online Service, then there are
many options available to you to place your images accordingly in different scenes. 

In this section:
Print photos
Order photo prints
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Print photos
 Tip
: Use "Optimize" on MAGIX Photo Manager 10 Deluxe's main screen to adjust images with redeye or
color problems in order to get the best possible results. 

1.
 Select all images which you would like to print. 
2. To open the dialog, click the "Print
" button. 

Layout
: You can set how many pictures should be printed per page. You can choose from between 1 and 8
pictures per page. The more pictures found on any page, the smaller they will appear. With "Contact
sheet" you can have a type of index for all pictures printed. All pictures are ordered in mini format on one
page. Of course, you can also print your pictures in standard formats (9x13 and 10x15). 
Options
: Activate options by checking them off (and leave those unchecked which you don't want to activate).
For example, if you've saved comments on an image and want them to be visible on the printed page,
then activate "Print comments". If you've optimized several images or added effects, place a check next
to "Print optimization effects" so that the adjusted photos appear as you want them to. Click on "Default
settings" to reset things to their standard values. 
Quick settings
: This displays several typical settings for print jobs like posters and postcard puzzles, etc. Use one of
these settings and you will have to make sure that there are no adjustments to the settings under
"Options". 
Copies
: Set how many copies are to be created for the current print job. 
Landscape format
: Activate this button to print the image in a landscape (horizontal) format. 
Setting
: Open your printer's settings and customize them to meet your requirements. 

Click "Print" to start the print process. 
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Order photo prints
 Would you like to order prints of your pictures? It's easy! We'll show you how it works and in a few
days, you'll be holding your prints in your hands. 
Tip
: Via "Optimize" on MAGIX Photo Manager 10 Deluxe's main screen, you can adjust images with
redeye or color problems in order to get the best possible results. 

1.
 Select all images which you would like to order. 
Note: In MAGIX Online Print Service you can add
additional images from your hard disk. 
2. Click the "Photo prints" button. The print dialog
in the "Order prints
" area will open. 
Tip: Inform yourself about the current prices and
offers and stay up to date! 
3. Click Send selected photos
 to open MAGIX Online Print Service and upload
photos. 

MAGIX Online Print Service

Load new pictures into the list in order to add them to the
shopping cart. Remove the pictures that you do not want to
order prints of. 
Either add the selected images into the shopping cart (add
selected to shopping cart) or copy them all with the "All images"
button. 
The shopping cart features all of the images that you want to
order prints of. 
Note: If the number and image sizes differ for the desired prints,
then a mixed order will be processed. 
For each picture, enter the quantity and the desired size. 
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You can load the saved shopping cart in the job manager. 

Since our prices and the products on offer are subject to
change (e.g. special offers, etc.), you should refresh the prices
and products before every order by clicking "Update prices". 
If you would like to burn your shopping cart to disc, then use
this button. 
Tip: For large orders or slow Internet connections, we
recommend you burn the finished order to CD or DVD and
then send it to our labs. 
Click "Order online" to finish the order process via the Internet. 
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MAGIX Online Print Service

Load new pictures into the list in order to add them to the
shopping cart. Remove the pictures that you do not want to
order prints of. 
Either add the selected images into the shopping cart (add
selected to shopping cart) or copy them all with the "All images"
button. 
The shopping cart features all of the images that you want to
order prints of. 
Note: If the number and image sizes differ for the desired prints,
then a mixed order will be processed. 
For each picture, enter the quantity and the desired size. 

You can load the saved shopping cart in the job manager. 

Since our prices and the products on offer are subject to
change (e.g. special offers, etc.), you should refresh the prices
and products before every order by clicking "Update prices". 
If you would like to burn your shopping cart to disc, then use
this button. 
Tip: For large orders or slow Internet connections, we
recommend you burn the finished order to CD or DVD and
then send it to our labs. 
Click "Order online" to finish the order process via the Internet. 
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Create map
 Use this function to document travel routes or directions, to mark your favorite cities, and so on. 
For example, add all of the locations from your trip and these will be displayed on the map. Connect the
locations with lines by pressing "Display lines", then save the map to integrate it into your vacation
slideshow. 
Note
: Detailed help regarding this is available directly via this small program. Once it is opened, press F1 on
the keyboard to open help. 

Map:
 Displays map material from openstreetmap.com. 
Selected locations:
 If you look for a new location, then this will be provided via
geonames.org and entered on the map. All of the locations that
you have selected on the map will be displayed in the list, and
corresponding markers appear on the map. 
Map section + zoom:
 The map may be moved by pressing the arrows. "Zoom"
enables you to zoom into the current section (+) to view more
details or to zoom out (-) for a better overview. 
Show lines:
 If at least 2 locations are marked on the map, then this
function will be available for linking the locations. The line
color and thickness may be changed. 
Format:
 Set the map format to 16:9 or 4:3 as required. 
Save as image:
 The current map section may be saved as an image in the
format PNG, BMP, JPG, or TIFF. 
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Create panorama image
 This function will turn your photos into a sensation. Add new life to your holiday memories and create
great panoramas with only a few clicks - including automatic exposure recognition and lens
distortion/perspective correction. 
You don't need to create "proper" panoramas exclusively; Let your imagination run wild and put together
anything you want to. You'll see your photos in a new light and create stunning montages. 
You can find this function in the "Edit" menu > "Create panorama image", and also in the context menu of
one or multiple selected images. 

1. Select all of the photos which you would like to add to the panorama (6 maximum).
2. Open the panorama dialog.
3. Change the sequence of the images as you see fit.
4. Under "Panorama file name and destination folder:" you can change this information as you

desire.
5. Click on "Create" to run the automation.

The finished panorama made of 2 images:

 Tip:
 You can also create "portrait panoramas". Just clip the photos you would like to be stacked on their
side. Create a panorama and turn the resulting image 90°! 
In this section:
Tips for creating panoramas
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Tips for creating panoramas
 In general, you can use any images to create panoramas, however, a couple of things should be
considered if they are to look professional (i.e. the edges between the images are not visible). 
First, pay attention to the image overlap and the difference in brightness between the images. 
The image overlap displays the part of the neighboring image where the pictures should be matched up
according to the image and brightness. If this part is too large, then you will have to adjust the settings
accordingly. A maximum overlap of 70% can be expected, but up to 90% is allowed. In any case, this
will negatively affect calculation time, i.e. it will take longer for the panorama to be created. 50% image
overlap is recommended to achieve optimum results. 
When creating images which you would definitely like to use for a panorama image, pay attention to the
difference in brightness between the images. Also, make sure you have enough details in the image. If the
difference in brightness is too extreme, then manual correction may be necessary. 
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MAGIX Media Viewer
 This small MAGIX program is also automatically installed when MAGIX Photo Manager 10 Deluxe is
installed to provide more options for viewing your photos and videos. 

 The Media Viewer may be started quickly by pressing the "Slideshow" button. 
 The menu item "Edit -> Slideshow -> MAGIX Media Viewer" may also be used to open the

program, and the slideshow will start automatically.
 It's also available via "Start -> Programs -> MAGIX -> MAGIX Photo Manager 10 Deluxe ->

Other programs -> MAGIX Media Viewer".
Burn slideshow and use MAGIX Media Viewer for playback
: Burn a slideshow CD/DVD and Media Viewer will also be added as a the player. Insert the medium
into the drive and the slideshow will start automatically; photos/videos will be played back automatically
with Media Viewer. 
Note
: Detailed help regarding this is available directly via this small program. Once it is opened, press F1 on
the keyboard to open help. 

Gallery
: Contains all media files that are dragged and dropped into
MAGIX Photo Manager 10 Deluxe. 
Display screen
: Displays the current media. If this is an audio or a video file it
will play. 
Transport control
: The program or media settings can be changed here. 
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Adjust properties
 If you want to check a music track for its properties or make changes, you can view the already
available information and add more via the "Properties" dialog. All changes that you make to the ID3 tags
will be visible here. 
The dialog can be opened by right clicking on a file or via "Edit -> Properties". 

Contents
: In this tab you can find the most important file properties. You can change ID3 tag information simply
by entering it here. 

 Especially interesting is the ratings system for your pictures: 1 star = not so great, 5 stars =
fantastic. The stars awarded will then be shown at the bottom edge of the picture and sorted
accordingly into the tab "Categories -> My ratings".

 Another highlight is the ability to assign every image file to the right category directly.
EXIF
: Data about the picture included by the camera, e.g. focal distance and resolution units. 
General
: Further general properties of the file are displayed here, i.e. size, modification date, etc. They can't be
changed. 

You can also load several files simultaneously with the editor. Use the arrow buttons at the bottom to
change to the next/previous file. The "Replace in all files" button applies changes to all selected files. 
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Equalizer
 Equalizer
 The 10-band equalizer splits the frequency spectrum into 10 areas ("bands") and provides a separate
volume slider for each band. Add impressive effects, from simple bass boosts to complete sound
distortion. If the frequencies are raised too much, particularly low frequencies, the total frequency is
increase high enough for distortions to develop. In such a case you should use the volume controller at
the center to reduce the total volume. 
Slider: 
Each of the 10 frequency bands can be adjusted using the 10 volume faders. 
Presets:
 The EQ has a selection of defaulted presets which can be chosen from a flip menu. 
Click "Reset" to remove the applied preset. 
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Functions in detail
 For advanced functions, you will find detailed explanations and instructions for correct operation in this
chapter. 
In this chapter
Multiple rename
Inserting and editing images from the clipboard
Work in networks
Multi-user support
Create backup copy on CD/DVD
MAGIX Photo Designer
Working with MAGIX Online Album
Digital picture frames
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Multiple rename
 The Multiple rename
 function provides a great opportunity to title (if desired) your files. This way you can save multiple files or
folders all at once. 
Note
: To select multiple files/folders, hold down "Shift" and click on the first and last files that you wish to
rename. They now appear dark gray (selected). Multiple individual files can be selected by clicking on
them while holding down the "Ctrl" key. 

Presets
 Click on the preset button to load various preset masks for summarizing the new file names. You can
also save masks for later renaming by selecting Save mask in the preset list
. Please don't forget to name your new mask logically. These personal masks then appear in the lower
half of the preset list. 

Create new folder
 If you insert a backslash into the mask (\, or Alt Gr + ?
), the corresponding subfolders that you entered as variables are created. For example, the mask
"[A]\[B]\[C]-[T]" creates the corresponding folders for "Artists" and then the additional folder for
"Albums", into which all correspondingly renamed files are moved. 
Additional variable editing options
 Enter only certain aspects of a variable
: You can tell variable B (Album) to use only the first 3 letters of the album name. To do this, you have to
write the number 3 in along with variable B, i.e. [B3]. 
Variable content upper/lower case
: To have variables written either only in upper or lower case, add the corresponding variable at the end
written in either upper or lower case. For example, use [TT] to have the complete title written in
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uppercase. 
Variable separators hms and YMD
: A hyphen behind the hms or YMD variable will result in time entry being written separated by a dash.
You can also enter other characters instead of the hyphen (space, underscore...). The order of either
variable can also be changed. 
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Inserting and editing images from the
clipboard
 Make a screenshot by pressing "Print screen" on the keyboard. Next, select MAGIX Photo Manager
10 Deluxe's "Edit" menu, and then "Insert". The "Save as..." dialog appears. 
Enter a logical name in the "File name" text field. You can also select a folder where the screenshot
should be saved (so that you can locate it later). Click "Save" to confirm the action and the screenshot
will be added. 
Navigate in MAGIX Photo Manager 10 Deluxe to the image you just created to edit it and use it as you
wish. 
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Work in networks
 In MAGIX Photo Manager 10 Deluxe, you can also work in networks as if they were the normal
folders on your computer, but of course only if you are authorized to access all of the folders of the
individual network users. 
Would you like to manage the music of a network user in your folder? No problem for MAGIX Photo
Manager 10 Deluxe. Click in the network on this folder and confirm that you would like to manage this
media in your folder by clicking "Yes". 
In order to avoid having to click through the whole network to a specific network user, you can also 
save the network path
. In this way, you can click on the network path in My Computer to access the user's folder. If the
network path changes, then this can always be changed or completely deleted. Open the network path's
context menu to do this. 
Here's how you add a network path
: 

1. Open up My Computer -> Network paths and then open the respective network group and
then select the desired network users.

2. Open the context menu and then Add network paths.
3. Enter the network path to the computer and the authorized folder. For example, \\Matthew\files

-> the computer is named "Matthew" and the authorized folder "files".
4. If a name and password have been entered to use the network, then this will have to be given

under Log in to the network with the following data.
5. Confirm your entries with OK.
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Multi-user support
 Multi-user support makes it possible to save program settings for each Windows user separately. Files
and folders in the database may also be locked for other users. These will then no longer be visible to
other users. This lock applies to all database views in all MAGIX programs, i.e. multiple settings do not
need to be made. 
Note!
 This is not a security function! These files will not be protected against external access in this manner!
They will still be able to be located by other users in the file system and used as long as Windows file
permissions allow this. 
Activate the multi-user support via the options (shortcut: "Ctrl + '") or via "File > Options > General". 
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Create backup copy on CD/DVD
 In order to ensure that your valuable material is not accidentally changed or even deleted, we
recommend burning backup copies to CD or DVD after importing. Creating regular disc backups of
your images will ensure that your important memories are protected. 
MAGIX Photo Manager 10 Deluxe features an automation for your backups which you can find in the
"Security" menu, "Create backup copy -> Create backup copy on CD/DVD". 

In this section:
Advanced settings
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Advanced settings

 Under "Advanced" you can access a list with all files in the Database (2) that have not yet been backed
up or that have been changed since the last backup. You can activate or deactivate all folders or files for
the backup (1). Specify whether you would like to burn a DVD or a CD (3)
. 
Clicking on "OK" opens the burning window. 
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MAGIX Photo Designer
 In the MAGIX Photo Designer section you can choose from a number of different tasks. MAGIX Photo
Designer loads the current image into a separate image processing program, which then performs the
selected tasks. 

The comprehensive image processing software from MAGIX possesses an extremely extensive effect
browser and a large set of filters. You can use them to distort your pictures' motifs or change the style of
the photo into a painting or screen print. 
In MAGIX Photo Designer you can also quickly optimize your photos. For this you will find "Red eye
correction" and other tools to correct mistakes and unfocused pictures. The best example for this type of
application are old photos that you might want to scan in and digitally restore. The functions for cutting
out objects with the lasso tool or the cloning function for retouching distorted picture details are also quite
helpful. 
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Working with MAGIX Online Album
 Managing and caring for your MAGIX Online Album is easy with MAGIX Photo Manager 10 Deluxe.
In just a few steps, your media will appear on the Internet. 
Learn about how to load media from MAGIX Online Album to your computer again in the chapter 
Importing from your MAGIX Online Album
. 
In this section:
Registration
Send media to Online Album
Import from your MAGIX Online Album
Managing your Online Album
Create new album
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Registration
 Before you receive access to your Online Album, you will have to register with MAGIX. Then you will
not only have access to all of MAGIX Online World, but you will also be able to download patches
(program improvements) for your MAGIX program. 
A)
 If you are already a registered MAGIX customer, then just enter your email address (login name) that
you used to register with MAGIX. Enter the password you used when you registered. Next, click "OK". 
B)
 If you aren't registered with MAGIX yet, then select "Info & Registration". This will direct you to the
registration page. 

 Decide whether you want a free, classic, or premium album. Click accordingly below the album
on "Register now". You can always upgrade your album to another format.

 On the next page, select "I'm not registered yet", and then click on "Next". Fill out the short form
for general registration with MAGIX and then send it to MAGIX by clicking "Finished".

 You will receive a confirmation email from MAGIX, and then you will be immediately able to log
in to any MAGIX service with your email address and password.
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Send media to Online Album
  In <fotomaneger>, select all files which you would like to add to the album.

Note
: Only MP3 files can be uploaded as audio. 

 Click on the Online Album button. 

The Online Album dialog will appear: 
 Click the "Send selected files" button to start the send process to your Online Album. The

login dialog appears.
 Enter your Login name and the Password for your Online Album, and then confirm with OK.

Note: If you don't have an Online Album yet, then click Info & Registration
. Here you can register for your free MAGIX Album. 

 Once the upload dialog for the Online Album has opened, follow the instructions: Select image
quality and enter a folder where you would like to load your files. 

Next, the files will be uploaded and you can look at your images online. 
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Import from your MAGIX Online Album
 If you would like to load media from your MAGIX Online Album to your computer, then proceed as
follows: 

Step 1:
 Click the "Online Album" button. 

Step 2: Switch to the "Manage" screen and log in.
The dialog for managing your MAGIX Online Album will open. 
Step 3: Go the album/folder which contains the media that you want to copy to your hard disk.
All media in the album will be displayed. 
Step 4:
 Under "Save downloaded media in", enter the folder on your hard drive where the media should be
copied. 

If you only want to copy a few files
from the Online Album, then select
these and click "Download selected". 
If you want to copy all of the media,
then select "Download all". 
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Managing your Online Album
 Click on the Online Album button. 

 Switch to the Manage area and log yourself in.
The dialog for managing your MAGIX Online Album will open. 

If you manage multiple Online Albums, then you can choose
which one you want to work on here. 
Preview the album in the Internet browser. 

The list with the albums of your Online Album. Click on an
album and the media contained within it will be displayed in the
view (5
). 
Select specific media in your Online Album and choose Move
media to move items to different folders, or select Delete
media
 to delete items from your Online Album completely. 
Select an album and click on "Add media"
 to copy music, images, and video files to your online album. 
All media in the album will be displayed. 

If you would like to download media from your album, enter
the folder where the media should be copied. 
Select either "Download selected" to download only that
which you have selected, and "Download all"
 to copy all media (selected or not). 
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Create new album
 Don't just load media into existing albums, but create new ones too (it's easy): 
1.
 Right click on a folder or an album to open a submenu where you can "Add a new album...". 

A dialog opens to "Create a new album". 
2.
 Select the type of album. For a purely photographic album, choose "Photo"; for all audio, select "Audio",
etc. If you would like to feature multiple types of media in a single album, then select "Mix". 
3.
 Enter a clear name for your album under "Album name". This name will also appear on your Online
Album website. 
4.
 If you want to, you can also give the album a text description (under "Album description"), and your
visitors will see this description as they roll over the album with the mouse. That way they can get an idea
of the contents without opening the album. 
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Digital picture frames
 Digital picture frames are becoming more and more dynamic; even the options for transferring to them
are becoming more advanced. From a simple USB connection to transfer via Bluetooth or infrared, take
this opportunity learn a little more about digital picture frames. 
The following items should be noted when purchasing a digital picture frame: 

 It doesn't matter whether 7 or 8" display, avoid frames which only work with 480 x 234 pixels.
To display pictures sharply, you will require at least 720 x 480 pixels. 800 x 600 pixels would be
optimum according to the current level of technology. 4 inch displays with 480 x 234 pixels are
adequate (ratio of pixels to display is sufficient).

 Please bear in mind that many digital frames can acquired with 16:9 format, but digital cameras
produce images in 4:3 or 3:2 format, which means your photos will be cut off in the frames to
avoid black bands on the edges.

In this section:
Connecting digital picture frames
Image selection
Crop image
Permitted formats
Export pictures
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Connecting digital picture frames
 Connect via the USB port 
Several picture frames contain proprietary drivers so that they are recognized immediately when they are
connected and displayed with the correct name in Explorer. 
Some, however, are missing these drivers. These frames will be named "Removable storage device" by
Windows. In this case, the location of the frame may be referred to by the name of the storage card
inside it (provided one is integrated). 
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Image selection
 The following things should be considered when selecting pictures: 

 Photo selection should be considered in terms of their format - i.e. portrait. Most frames at the
moment cannot automatically turn images so that individual pictures are displayed correctly. If this
function should be integrated, then black bars will be displayed because the format changes. If
you want to avoid this, then just select images of a single format (landscape or portrait).

Tip
: Create a new album with all of the images that you want to transfer to your digital picture frame. This
will make it easy to have a clear overview. 

 To fully utilize your picture frame's memory, you should first convert the images to the optimum
dimensions on your PC. The larger the image, the larger the file and the fewer images will be able
to fit on the frame. Under Export images you can learn about the process.
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Crop image
 It's not always the case that every detail of an image needs to be saved forever. Sometimes even the
arrangement of objects in an image can be adjusted. For this purpose, cropping certain areas as a
separate image or the removal of unwanted details at the edges can be helpful. 
To do this, proceed as follows: 

1. Activate MAGIX Photo Manager 10 Deluxe's "Optimize" mode. To the left in the program, tabs
appear with the editing functions for your images.

2. Below the basic functions, you can see the "Cut image" button. Clicking on this button
activates this function.

3. Hold down the left mouse button while you draw out the cut over the image.
4. The orange-colored handles around the cut window can be manipulated to adjust the size.
5. Once you've entered the correct size for your cut, click on "Accept" and the image will be

reduced to your specifications.
"Reset all" returns the image to its original form. Click on Fix effects
, and the effects will be written to the original image. 
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Permitted formats
 Export formats for single images for display on digital picture frames: 

 JPEG (*.jpg/*.jpeg) or 
 BMP (*.bmp), 
 PSD (*.psd), 
 TIFF (*.tif)

etc. 
Note
: Pay attention to the formats which are supported by the picture frame! 
Or, create slideshows and videos in the following formats, and then transfer these to your frames: 

 AVI (*.avi) or
 WMV (*.wmv),
 MOV (*.mov) (with installed codec), 
 RealVideo (*.rv) and 
 MAGIX Video (*.mxv).

Note
: Pay attention to the formats which are supported by the picture frame! The most conventional image
formats are AVI, MOV, and WMV. 
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Export pictures
1.  Select all of the images that you would like to transfer to your picture frame.
2. Click on "Export" on the toolbar. The corresponding dialog opens.
3. Select the "Transfer" category and then "Transfer to mobile device".
4. Click on "OK" to confirm. Another dialog will open.
5. Select "Mobile devices" and then your digital frame. Adjust the target path as needed via

"Change".
6. "Effects & size" enables you to enter the respective values for the frame.
7. Confirm your entries by clicking "Execute". The transfer process will start
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Menu
 In this chapter you'll find the full menu list of your copy of MAGIX Photo Manager 10 Deluxe and the
corresponding functions. 
In this chapter
File menu
Edit menu
Library menu
Security menu
Windows menu
Online menu
Tasks menu
Help Menu
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File menu
In this section:
New photo album
Open photo album
Save photo album
Save photo album as...
New directory
Create map...
Scan
Exporting the photo album
Burn CD...
CD/DVD burner
MAGIX Xtreme Print Center
Options
Advanced mode
Change screen
Exit
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New photo album
 This option creates a new photo album. Hold down the left mouse button and drag the files from the
overview on the right to the photo album on the left! 
Shortcut key: Shift + N 
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Open photo album
 This option lets you load a previously created and saved photo album. 
Shortcut key: Shift + O 
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Save photo album
 Use this option to save a photo album. 
Shortcut key: Shift + S 
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Save photo album as...
 This option lets you save an existing photo album with a new name and in a new folder. 
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New directory
 Creates a new folder inside the currently open folder and opens an editor in which you can name the
new folder. 
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Create map...
 Select locations on the map to save them as an image for a description of a trip route. 
Note
: Detailed help regarding this is available directly via this small program. Once it is opened, press F1 on
the keyboard to open help. 
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Scan

 Scan with
 The scan window of your scan software will appear. Specify the resolution and color depth in this
window. 
When the scan is complete, the TWAIN software should close automatically and MAGIX Photo
Manager 10 Deluxe should now contain the newly created image file. It's possible that the TWAIN
window remains open. You can then scan multiple pictures one after the other. 

Select source
 The TWAIN interface connects MAGIX Photo Manager 10 Deluxe with nearly all modern scanners or
digital cameras. To scan, please proceed as follows: 

1. Install the TWAIN software for your device. 
2. Restart you PC. 
3. Start MAGIX Photo Manager 10 Deluxe. 
4. Click on "File > Twain Scanner/Camera > Select source" if the scanner works with 32 bit

software. 
5. Select your device from the dialog. This step is only required once and only has to be repeated if

you want to change the device.
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Exporting the photo album
 This menu point opens the standard export dialog (Export, Present your photos
) wherein you can prepare your photo album for different export variations according to your wishes and
then export it. 
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Burn CD...
 If you want to burn picture files, albums or slideshows, you can specify all your settings in the burn
dialog. 
In the first dialog, select what type of medium you wish to burn. Less material fits on a data CD than on a
DVD. To create high-resolution slideshows, click on "WMV HD". To be able to play your slideshows
via your DVD player on TV, the burning process for burning JPEG discs has to be selected. 
In the next step you can add additional data to the burning process according to the type of media you
selected. Now start the burn process. 
You can find out more under: Burning data
. 
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CD/DVD burner
In this section:
CD drive info
CD info
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CD drive info
 Choose this option to display information about your CD-R drive. A blank CD must be in the drive for
this option to work. Among the information displayed is the manufacturer, drive name, hardware version,
cache size, and the features supported by the drive mechanism. 
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CD info
 This dialog box provides information on the blank CD. The maximum capacity is of particular
importance: for example, 74 minutes and 5 seconds of music fits onto the disc. 
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MAGIX Xtreme Print Center
 This menu entry starts the independent "MAGIX Print Center" program. The print studio is a printing
suite for cover and label printing for CDs, DVDs, and VHS tapes. You can easily print perfect stickers,
covers, inlays, and booklets. 
Note
: Use the included program help (via "F1"). 
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Options
 Note: The functions in the options dialog will only take effect after you click "Apply" and "OK" 
In this section:
Options > General options
Options -> Explorer
Options > File formats
Options > Path settings
Options > Audio
Options > Video
Options > Photo
Options > Database
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Options > General options
 Load recent photo album on program start
: This option always opens the last program according to the settings entered during the last session. 
Use multi-user support: If there are multiple users
 entered on the same system, then you can save different settings for each one of them. Additionally,
certain folders can be hidden from other users. 
Show tooltips via function keys
: Tooltips are small windows with info texts. They appear when the mouse pointer is positioned over a
function key. 
Allow dialog animations: 
The animation in the program can be switched off/on for weaker systems. 
Open encoder settings dialog before converting
: If this check box is deactivated, the last used settings or default settings for converting the images are
used. 
Use Windows photo print assistant for printing pictures
: The Windows print assistant is used instead of the MAGIX Photo Manager 10 Deluxe printing dialog.
This setting is recommended only if you experience problems during printing. 
Display news center
: If you don't want the small button for the "News Center" above and to the right to be displayed, then
remove the check mark here. 

Tips and information

 Reset
: Many information windows can be switched off permanently after being displayed. This option
reactivates all disabled information and confirmations. 
Online Service
 Settings
: Enter an alternative Online Service. 
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Options -> Explorer
 ID3Tag in Explorer
: Displays the ID3Tags contained in MP3 files (information on song, performer, etc.) directly in Explorer. 
Thumbnails (preview images)
 Show thumbnails
: Thumbnails are small icons used to preview images. This option activates the thumbnails. 
Generate thumbnails from JPGs without EXIF tag
: Some JPG files include thumbnails in an EXIF tag so that large images do not have to be scanned first to
be previewed. If this option is activated, a thumbnail is generated for each photo (even those without an
EXIF tag). 
Cache settings
 Use cache
: This function is normally active, since it guarantees faster launching of frequently needed files. 
Enter if a central cache should be used or a local one. When switching between local and central caches,
at first no cache files will be deleted or moved. "Older" cache files will only be deleted when you work on
those photos or videos, thereby creating new cache files (in the new folder). 
Audio comments
 Some digital cameras have an audio recording function and save a WAV file with each photo. The PC
identifies these cameras as separate drives; i t is automatically loaded when the photo is loaded. 
Hide comment files
: Audio comments are not displayed as separate files. However, a speaker symbol appears next to the
photo to indicate that an audio comment exists. 
Automatically apply file operations (copying, moving, deleting) to comment files
: Indicates whether file operations are to be applied to the audio comment file of a photo. 
Always play when displaying image/only play in photo album/never play audio comments
: Specifies when audio comments are to be played back. 
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Options > File formats
 Here you can assign different file formats to MAGIX Photo Manager 10 Deluxe. 
You can select the media to which you wish to connect file extensions in the flip menu. 
Registration
: The file extensions selected below will be assigned to MAGIX Photo Manager 10 Deluxe, that is, they
will be opened with the program as default. 
MAGIX Use viewer: 
MAGIX  The MAGIX Viewer is a component of MAGIX Photo Manager 10 Deluxe which opens
quickly without consuming too much proecessor power. 
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Options > Path settings
 Here you can adjust the paths for standard folders. You can normally leave these settings as they are. 
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Options > Audio
 On this page, you can decide which sound driver the program is going to use. Setting this up is only
necessary if multiple sound cards are installed on your PC or if you are having problems with the sound
output. Apart from the driver, you can adjust the size of the data buffer for RAM and hard disk that is
created by MAGIX Photo Manager 10 Deluxe. 
Audio buffer (ms)/Latency:
 To enable a smooth workflow, MAGIX Photo Manager 10 Deluxe creates a so-called audio buffer into
which the current file is saved during playback. You can set the size of the buffer in milliseconds (ms). 
Latency:
 The latency can be seen as the reaction time of MAGIX Photo Manager 10 Deluxe. It sets how quickly
changes (such as effects, starting and stopping playback) can be heard. It can be adjusted in 5
millisecond increments and can be max. half as long as the audio buffer. 
A rule of thumb is:
 If loading and waiting times are long, the latency should be reduced, but if repeated real-time editing
errors are experienced, then it should be lengthened. 
Hard disk buffer:
 The hard disk buffer is a temporary memory buffer on the hard drive used by MAGIX Photo Manager
10 Deluxe for data processing. Use this option to specify the size of the hard drive buffer in bytes.
Increase the buffer size if playback is choppy or interrupted. 
Sound card: This lists all of the DirectSound drivers installed on your system. The primary audio driver is
selected by default and is generally what your system uses for audio output.
Change this driver only if you really want to play a playlist using another sound card or another output. If
the sound card does not have a true DirectSound driver, then an emulated driver will be listed: "Sound
card XYZ (emulated)". In emulation mode MAGIX Photo Manager 10 Deluxe uses the sound card,
however, optimum performance can not be reached. 
Important:
 The selection of a different sound card is not taken into account until MAGIX Photo Manager 10
Deluxe has restarted. 
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Options > Video
 Play video
 Automatic video playback optimization
: Sound and effects will not be included in order to be able to playback the video. 
Balance aspect ratio
: Adjusts the aspect ratio of images to the video monitor. If disabled and depending upon the image
format, black stripes may appear on the borders. 
Complete fields (deinterlace) if possible
: This effect is mainly intended for snapshots of video images, since the field technology in TVs often
produces an unusable image if the fields differ too much. 
Preferred DV video resolution
: The resolutions that can be set here only concern the picture display of DV videos. If playback
becomes jerky, we recommend entering a lower value. The quality of exported videos is not influenced
by this. DV video resolution can be altered during playback either automatically or you can choose
between full and 1/8 resolution. 
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Options > Photo
 Slideshow options
 Configures the slideshow default settings. 
Change image every [...] seconds: 
Specifies how long the image is displayed. 
Image crossfade:
 Activates/deactivates soft image fading. 
Duration: 
Specifies the duration of the soft fade. 
Maintain the proportions of the pictures (add borders):
 The original length/width ratio is retained when zooming. If necessary, borders are added. If the option is
deactivated, image distortion may occur. 
When finished, restart from beginning:
 This option plays the slideshow in loop mode. This lets you create animations for parties as loops. 
Photo settings
 Here you can choose whether you would like to enlarge smaller photos or save the optimizations you
made in the optimization view as a file which can then be applied to other pictures later. 
Enlarge small photos
: Small photos are increased in size even if they have lower resolution than is possible in the filmstrip view
or in the slideshow monitor. 
Non-destructive FX
: When this option is activated, all adjustments made to images can be undone. If the option is
deactivated, then all optimizations made to the images will be applied directly to the image, and the
original will not be able to be restored. 
Note
: It is strongly recommended that this option be left active to ensure that changes remain reversible, or
that work is performed on a copy of the image. 
Allow pan
: If you are viewing panoramas in MAGIX Photo Manager 10 Deluxe, then you can can watch them
using a continuous pan in MAGIX Photo Manager 10 Deluxe. Zooming in or out stops the movement.
Deactivate this function, if you would like to view the panorama alone like every other image. 
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Options > Database
 Behavior for new files
 Automatically update MAGIX Media Database
: The database is updated automatically if you add new music to your PC with MAGIX Photo Manager
10 Deluxe or delete old items. Alternatively, you can select the "Optimize database" function in the
"Database" menu. Files that are no longer available but are still listed in the database (so-called "dead"
entries) are then removed; moved files are located automatically. 
Backups of files
 Start
: Starts the assistant for support with backup copies. 
Reset
: Manually excluded files will be offered again for backup. 
Creates a backup copy of imported files in the following folder
: Backup copies of imported files are inserted into the selected folder. You can normally leave this setting
as it is. 
Older program versions
 Start
: Searches for older program versions in order to add their database information and favorites. 
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Advanced mode
 If this menu entry is activated with a check mark, then you will be working in advanced mode with all of
MAGIX Photo Manager 10 Deluxe's available functions. Click here, if you would like to return to easy
mode and show only the basic program functions (check mark disappears). 
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Change screen
 MAGIX Photo Manager 10 Deluxe includes 2 home-made skins for you to decide between, depending
on your taste. 
Open "Window -> Change skin" and switch MAGIX Photo Manager 10 Deluxe to a brighter
background, if you desire. You can always select the other skin, if you want to. 
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Exit
 Closes MAGIX Photo Manager 10 Deluxe. 
Keyboard shortcut: Alt + F4 
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Edit menu
 Right click on a file in the photo overview to open the context menu where you can choose from several
different options. While these can also be found in the button bar and in the menu, using the context menu
is the most convenient and fastest method. 
In this section:
Optimize photo
Slideshow
Export
Print
Send as email...
Adjust red-eye automatically
Correct curved lines...
Assign categories automatically
Create panorama image...
Create map...
Record audio comments
Find similar photos...
Select all
Cut
Copy
Insert
Copy into folder
Rename
Multiple rename...
Fade out
Delete
Rebuild preview pictures
Delete the category
Open Windows Explorer
Properties (ID3)
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Optimize photo
 To optimize
 your photos, click here and the corresponding functions will appear on the left. 
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Slideshow
 View as slideshow
: To create a slideshow with the pictures from one folder, it is enough to select one graphic file out of the
folder and to select this function. 
Slideshow options
: Here you can access the "Slideshow options" dialog, which enables you to specify how long each slide
should be displayed and the kind of transitions between pictures. 

MAGIX Media Viewer
: This is a small extra program from MAGIX which offers additional options for presenting videos and
slideshows. For example, a slideshow may be played back in Media Viewer with different transition
effects. 
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Export
This option provides different ways of saving
images as files. Here, the same dialog opens as
would when clicking on the button in the
toolbar. 

Please read the options in the "Export" (Export, Present your photos
) chapter. 
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Print
 This command opens the print window for printing the selected image files. 
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Send as email...
 MAGIX Online Album, MAGIX Print Studio
: Send the photos and videos you like to your Online Album to present them online, or send pictures to
the print service to get prints of your favorite images. 
To email recipient...
: This option opens your email program and inserts the selected photo into a new message as an
attachment. Just enter the recipient and subject and send! 
As ZIP to email recipient
: This option opens your email program and inserts the selected photo into a new message as a
compressed zip (with less volume). The zip file will have to be decompressed by the recipient to be able
to view the photos. 
Export tomobile device, export photo album to mobile device
: Send the desired files or entire photo albums to the connected mobile device. 
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Adjust red-eye automatically
 Select one or more pictures (even whole folders) and remove unnatural redeye automatically which are
the results from using a flash. 
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Correct curved lines...
 This function may be used to correct curved lines in pictures resulting from perspective distortions.
"Curved lines" are lines and edges, which run together in an image, although they are parallel to each
other in reality. 
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Assign categories automatically
 MAGIX Photo Manager 10 Deluxe can automatically assign your photos to specific categories. Select a
folder or different images and activate the "Automatically assign images to categories" in the "Edit" menu.
Images will then be analyzed for certain image content and sorted into corresponding categories (e.g.
night, sunset). The automatic categories may be found in the "Categories" tab under "Automatic
categories". 
This function should be understood as a rough presorting feature. Images may not always be assigned to
categories correctly, and sometimes they may be assigned to completely different categories. This
depends on the diversity of the photo's subject, which may be interpreted differently. 

Create panorama image...
 With only a single click you can create a panorama
 in MAGIX Photo Manager 10 Deluxe. You can do this fully automatic or manually; try experimenting
with it. 
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Create panorama image...
 With only a single click you can create a panorama
 in MAGIX Photo Manager 10 Deluxe. You can do this fully automatic or manually; try experimenting
with it. 
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Create map...
 Select locations on the map to save them as an image for a description of a trip route. 
Note
: Detailed help regarding this is available directly via this small program. Once it is opened, press F1 on
the keyboard to open help. 
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Record audio comments
 This option opens a recording window for recording sound via the PC's sound card. You can add a
soundtrack to the selected photo. If you have a microphone connected to your PC, simply click on the
recording button to start. 
There's more info available here ->General buttons and Options -> Explorer
. 

Find similar photos...
 Here you can search for photos that resemble the selected photo's color and/or structure. 
Please refer to the "Search in database"
 chapter. 

Select all
 This option lets you select all files of the current folder. 
Shortcut: Ctrl + A 

Cut
 This option cuts all selected files and copies them to the Windows™ clipboard. You can then use the
"Paste" command to copy them into a different folder. 
Shortcut: Ctrl + X 

Copy
 This command copies the selected files to the Windows™ clipboard. You can then use the "Paste"
command to copy them into a different folder. 
Shortcut: Shift + C 

Insert
 With this command, the content of the Windows™ clipboard is inserted into the current folder. 
Shortcut: Ctrl + V 
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Find similar photos...
 Here you can search for photos that resemble the selected photo's color and/or structure. 
Please refer to the "Search in database"
 chapter. 

Select all
 This option lets you select all files of the current folder. 
Shortcut: Ctrl + A 

Cut
 This option cuts all selected files and copies them to the Windows™ clipboard. You can then use the
"Paste" command to copy them into a different folder. 
Shortcut: Ctrl + X 

Copy
 This command copies the selected files to the Windows™ clipboard. You can then use the "Paste"
command to copy them into a different folder. 
Shortcut: Shift + C 

Insert
 With this command, the content of the Windows™ clipboard is inserted into the current folder. 
Shortcut: Ctrl + V 
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Select all
 This option lets you select all files of the current folder. 
Shortcut: Ctrl + A 

Cut
 This option cuts all selected files and copies them to the Windows™ clipboard. You can then use the
"Paste" command to copy them into a different folder. 
Shortcut: Ctrl + X 

Copy
 This command copies the selected files to the Windows™ clipboard. You can then use the "Paste"
command to copy them into a different folder. 
Shortcut: Shift + C 

Insert
 With this command, the content of the Windows™ clipboard is inserted into the current folder. 
Shortcut: Ctrl + V 
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Cut
 This option cuts all selected files and copies them to the Windows™ clipboard. You can then use the
"Paste" command to copy them into a different folder. 
Shortcut: Ctrl + X 

Copy
 This command copies the selected files to the Windows™ clipboard. You can then use the "Paste"
command to copy them into a different folder. 
Shortcut: Shift + C 

Insert
 With this command, the content of the Windows™ clipboard is inserted into the current folder. 
Shortcut: Ctrl + V 
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Copy
 This command copies the selected files to the Windows™ clipboard. You can then use the "Paste"
command to copy them into a different folder. 
Shortcut: Shift + C 

Insert
 With this command, the content of the Windows™ clipboard is inserted into the current folder. 
Shortcut: Ctrl + V 
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Insert
 With this command, the content of the Windows™ clipboard is inserted into the current folder. 
Shortcut: Ctrl + V 

Page 193



Copy into folder
 This option enables copying selected files into any folder. 

Rename
 This command in the context menu lets you rename the selected audio file. 
Shortcut: N 

Multiple rename...
 To adapt many music tracks that have many identical properties, use the multiple rename dialog to make
changing the name of the selected files easier. Select one or several file(s) and then select this menu item. 
More on "Multiple renaming". 

Fade out
 With this function you can fade out individual files. These files will be put into a special folder "Hidden
files or folders" within the currently selected folder. 
This way hidden files can be shown again if so desired. To do this, right-click on this folder and select the
corresponding function from the context menu that appears. 

Delete
 The selected entry will be sent to the Recycle Bin. By holding down "Shift" the file will be directly
deleted. 
Shortcut: Shift + Del 

Rebuild preview pictures
 It may be the case that MAGIX Photo Manager 10 Deluxe no longer shows the preview pictures of
your files, but just the standard views according to the file types (for example: jpg or bmp). In such a
case, select this function and MAGIX Photo Manager 10 Deluxe will generate preview pictures again. 
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Rename
 This command in the context menu lets you rename the selected audio file. 
Shortcut: N 

Multiple rename...
 To adapt many music tracks that have many identical properties, use the multiple rename dialog to make
changing the name of the selected files easier. Select one or several file(s) and then select this menu item. 
More on "Multiple renaming". 

Fade out
 With this function you can fade out individual files. These files will be put into a special folder "Hidden
files or folders" within the currently selected folder. 
This way hidden files can be shown again if so desired. To do this, right-click on this folder and select the
corresponding function from the context menu that appears. 

Delete
 The selected entry will be sent to the Recycle Bin. By holding down "Shift" the file will be directly
deleted. 
Shortcut: Shift + Del 

Rebuild preview pictures
 It may be the case that MAGIX Photo Manager 10 Deluxe no longer shows the preview pictures of
your files, but just the standard views according to the file types (for example: jpg or bmp). In such a
case, select this function and MAGIX Photo Manager 10 Deluxe will generate preview pictures again. 
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Multiple rename...
 To adapt many music tracks that have many identical properties, use the multiple rename dialog to make
changing the name of the selected files easier. Select one or several file(s) and then select this menu item. 
More on "Multiple renaming". 

Fade out
 With this function you can fade out individual files. These files will be put into a special folder "Hidden
files or folders" within the currently selected folder. 
This way hidden files can be shown again if so desired. To do this, right-click on this folder and select the
corresponding function from the context menu that appears. 

Delete
 The selected entry will be sent to the Recycle Bin. By holding down "Shift" the file will be directly
deleted. 
Shortcut: Shift + Del 

Rebuild preview pictures
 It may be the case that MAGIX Photo Manager 10 Deluxe no longer shows the preview pictures of
your files, but just the standard views according to the file types (for example: jpg or bmp). In such a
case, select this function and MAGIX Photo Manager 10 Deluxe will generate preview pictures again. 
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Fade out
 With this function you can fade out individual files. These files will be put into a special folder "Hidden
files or folders" within the currently selected folder. 
This way hidden files can be shown again if so desired. To do this, right-click on this folder and select the
corresponding function from the context menu that appears. 

Delete
 The selected entry will be sent to the Recycle Bin. By holding down "Shift" the file will be directly
deleted. 
Shortcut: Shift + Del 

Rebuild preview pictures
 It may be the case that MAGIX Photo Manager 10 Deluxe no longer shows the preview pictures of
your files, but just the standard views according to the file types (for example: jpg or bmp). In such a
case, select this function and MAGIX Photo Manager 10 Deluxe will generate preview pictures again. 
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Delete
 The selected entry will be sent to the Recycle Bin. By holding down "Shift" the file will be directly
deleted. 
Shortcut: Shift + Del 

Rebuild preview pictures
 It may be the case that MAGIX Photo Manager 10 Deluxe no longer shows the preview pictures of
your files, but just the standard views according to the file types (for example: jpg or bmp). In such a
case, select this function and MAGIX Photo Manager 10 Deluxe will generate preview pictures again. 
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Rebuild preview pictures
 It may be the case that MAGIX Photo Manager 10 Deluxe no longer shows the preview pictures of
your files, but just the standard views according to the file types (for example: jpg or bmp). In such a
case, select this function and MAGIX Photo Manager 10 Deluxe will generate preview pictures again. 
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Delete the category
 Removes the categories from the pictures. 
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Open Windows Explorer
 This option opens Windows Explorer if you want to use see the files in a format you're familiar with. You
can also drag & drop the files into the database folder from Windows Explorer. 
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Properties (ID3)
 This option opens the properties dialog. You can add ID3 data of the files here. This information is also
used for cataloging in the database correctly. 
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Library menu
In this section:
Search database...
Add folder
Monitor folder
Optimize database...
Print export
Statistics
Load database...
Save database...
Restore
Delete entire database
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Search database...
 Click here and the search dialog in "Search the database"
 will open. 
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Add folder
 For MAGIX Photo Manager 10 Deluxe to add a specified folder on your computer to the database,
you can either click through "My Computer" to the folder to add the files to the database automatically,
or you can use the "Add folder" function. 

 A dialog opens for you to enter the path to the folder. You also have the option to "Include
subfolders": all subfolders which contain images will also be added to the database.

 "Monitor permanently": So that a folder is always in the most up-to-date condition, MAGIX
Photo Manager 10 Deluxe can monitor it permanently.

Note! The Database is actually composed of paths to the original files. The files remain at their original
positions, and no copies are produced. If you launch a file via the Database, then you are not opening a
copy, but rather the original
 file via the link! 

Page 205



Monitor folder
 Here you can select which folders should be monitored continuously. This means that if contents of a
folder located outside of MAGIX Photo Manager 10 Deluxe are changed, then the database will be
updated automatically the next time the program opens. 
Tip:
 Do not select especially large folders (for example, "My Documents") so that the startup of MAGIX
Photo Manager 10 Deluxe isn't unnecessarily overloaded. 

Optimize database...
 This function allows you to change or delete database entries that refer to displaced or deleted files. This
way you can keep your database up-to-date all the time. 

Print export
 Should you ever need a list of all audio, i.e. music files, photos or videos, then use the print export. Here
you can create a list that contains all the information you want, in the view you want. 
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Optimize database...
 This function allows you to change or delete database entries that refer to displaced or deleted files. This
way you can keep your database up-to-date all the time. 

Print export
 Should you ever need a list of all audio, i.e. music files, photos or videos, then use the print export. Here
you can create a list that contains all the information you want, in the view you want. 
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Print export
 Should you ever need a list of all audio, i.e. music files, photos or videos, then use the print export. Here
you can create a list that contains all the information you want, in the view you want. 
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Statistics
 Use this function to have statistics created for your database. Here, for example, you can see how large
your database is in total and how many picture files are contained within it. 

Load database...
 Use this function to load saved databases. This can be used to restore albums, categories, monitored
folders, etc. 

Save database...
 If you wish to save the current state of your database, use this function. This way you'll be sure that
created albums, categories, etc. can always be reloaded. 

Restore
 MAGIX Photo Manager 10 Deluxe automatically saves the state of the database after certain periods of
time. This way, you can be sure even without a backup copy that older states of your database can be
restored. 

Delete entire database
 If you want to delete a database so as to create a new empty one, you can use this function to do so. 
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Load database...
 Use this function to load saved databases. This can be used to restore albums, categories, monitored
folders, etc. 

Save database...
 If you wish to save the current state of your database, use this function. This way you'll be sure that
created albums, categories, etc. can always be reloaded. 

Restore
 MAGIX Photo Manager 10 Deluxe automatically saves the state of the database after certain periods of
time. This way, you can be sure even without a backup copy that older states of your database can be
restored. 

Delete entire database
 If you want to delete a database so as to create a new empty one, you can use this function to do so. 
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Save database...
 If you wish to save the current state of your database, use this function. This way you'll be sure that
created albums, categories, etc. can always be reloaded. 

Restore
 MAGIX Photo Manager 10 Deluxe automatically saves the state of the database after certain periods of
time. This way, you can be sure even without a backup copy that older states of your database can be
restored. 

Delete entire database
 If you want to delete a database so as to create a new empty one, you can use this function to do so. 
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Restore
 MAGIX Photo Manager 10 Deluxe automatically saves the state of the database after certain periods of
time. This way, you can be sure even without a backup copy that older states of your database can be
restored. 

Delete entire database
 If you want to delete a database so as to create a new empty one, you can use this function to do so. 
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Delete entire database
 If you want to delete a database so as to create a new empty one, you can use this function to do so. 
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Security menu
In this section:
Create backup copy on CD/DVD
Settings...
Create password-protected archive
Unzip archive with password
Show backups from import
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Create backup copy on CD/DVD
 In order to ensure that your valuable material is not accidentally changed or even deleted, we
recommend burning backup copies to CD or DVD after importing. If worst comes to worst, then you
will always have original material to fall back on. 
Further information can be found under "Backup copies on CD/DVD"
. 
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Settings...
 MAGIX Photo Manager 10 Deluxe can be set to automatically remind you to create backups. This
way, you can completely avoid the loss of valuable photos without even having to think about it. 
If you activate this support function, then you can specify the criteria for and time periods between back
up reminders from MAGIX Photo Manager 10 Deluxe. 
Please read the chapter "File -> Options -> Database". 

Create password-protected archive
 This option creates a new ZIP archive. This, for example, enables space-saving compression of several
files into a single ZIP file for sending in emails. 

Unzip archive with password
 This option is only available for ZIP files. The archive is opened and the included files are unzipped. 
If, on creation, a password has been entered, it will be required before being unpacked. Without the
correct password, you will not be able to unpack the archive. 

Show backups from import
 This option lets you display and select the backup copies that were created during the import process. 
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Create password-protected archive
 This option creates a new ZIP archive. This, for example, enables space-saving compression of several
files into a single ZIP file for sending in emails. 

Unzip archive with password
 This option is only available for ZIP files. The archive is opened and the included files are unzipped. 
If, on creation, a password has been entered, it will be required before being unpacked. Without the
correct password, you will not be able to unpack the archive. 

Show backups from import
 This option lets you display and select the backup copies that were created during the import process. 
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Unzip archive with password
 This option is only available for ZIP files. The archive is opened and the included files are unzipped. 
If, on creation, a password has been entered, it will be required before being unpacked. Without the
correct password, you will not be able to unpack the archive. 

Show backups from import
 This option lets you display and select the backup copies that were created during the import process. 
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Show backups from import
 This option lets you display and select the backup copies that were created during the import process. 
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Windows menu
In this section:
Slideshow monitor
Volume
Always in foreground
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Slideshow monitor
 Use this command to open the Slideshow Monitor
. This will open in fullscreen by default. 
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Volume
 Use this command to open the Equalizer and volume. These serve to adapt your sound to your listening
requirements, to match what you may have come to expect from a HiFi. 

For example, you can activate the "Dance_Electronic" preset to automatically set the corresponding
settings. 
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Always in foreground
 Prevents the program from being covered by other screens/windows 
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Online menu
 These are menu entries for all services
 available directly from within MAGIX Photo Manager 10 Deluxe. 

Upload media to facebook
 Upload selected photos and videos directly from MAGIX Photo Manager 10 Deluxe to your facebook
page. Simply select the desired file, and then select the service in the "Online" menu. A dialog enables you
to specify details about the file; next, log in and you'll see it all online. 

Upload media to YouTube
 Upload selected photos and videos directly from MAGIX Photo Manager 10 Deluxe to YouTube.
Simply select the desired file, and then select the service in the "Online" menu. A dialog enables you to
specify details about the file; next, log in and you'll see it all online. 

Upload media to flickR
 Upload selected photos and videos directly from MAGIX Photo Manager 10 Deluxe to your FlickR
page. Simply choose the desired file and then select this sevrice in the "Online" menu. A dialog allows you
to enter details about the file; next, log in and you'll see your picture online. 
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Upload media to facebook
 Upload selected photos and videos directly from MAGIX Photo Manager 10 Deluxe to your facebook
page. Simply select the desired file, and then select the service in the "Online" menu. A dialog enables you
to specify details about the file; next, log in and you'll see it all online. 

Upload media to YouTube
 Upload selected photos and videos directly from MAGIX Photo Manager 10 Deluxe to YouTube.
Simply select the desired file, and then select the service in the "Online" menu. A dialog enables you to
specify details about the file; next, log in and you'll see it all online. 

Upload media to flickR
 Upload selected photos and videos directly from MAGIX Photo Manager 10 Deluxe to your FlickR
page. Simply choose the desired file and then select this sevrice in the "Online" menu. A dialog allows you
to enter details about the file; next, log in and you'll see your picture online. 
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Upload media to YouTube
 Upload selected photos and videos directly from MAGIX Photo Manager 10 Deluxe to YouTube.
Simply select the desired file, and then select the service in the "Online" menu. A dialog enables you to
specify details about the file; next, log in and you'll see it all online. 

Upload media to flickR
 Upload selected photos and videos directly from MAGIX Photo Manager 10 Deluxe to your FlickR
page. Simply choose the desired file and then select this sevrice in the "Online" menu. A dialog allows you
to enter details about the file; next, log in and you'll see your picture online. 
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Upload media to flickR
 Upload selected photos and videos directly from MAGIX Photo Manager 10 Deluxe to your FlickR
page. Simply choose the desired file and then select this sevrice in the "Online" menu. A dialog allows you
to enter details about the file; next, log in and you'll see your picture online. 
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Tasks menu
 In this menu you will find direct solutions and short video explanations on how to perform tasks in
different topics. Not only will you find step-by-step instructions for sound and pictures here, you will also
find quick access to lots of functions. 
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Help Menu
In this section:
Help
Start introductory video
Online Update
Register online
Online tutorials
magix.info
MAGIX Screenshare
Reset program settings to default...
About MAGIX Photo Manager 10 Deluxe
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Help
 This command is available for almost every feature of the program, and it opens the "Help" file for the
corresponding topic. Use this command to get help on any of MAGIX Photo Manager 10 Deluxe's
functions. 
Keyboard shortcut: F1 
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Start introductory video
 The introductory video shows you how all the most important features work. Specific topics are
explained in detail in additional tutorial videos. 
Keyboard shortcut: Ctrl + F1 
To play the introductory video you may have to insert the program CD. 
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Online Update
 Connects directly to the online update page where you can get the latest version of your program. 
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Register online
 This option opens the MAGIX homepage for online registration where you can register yourself as a
MAGIX user. 
Registration grants you access to the MAGIX support website
 (see support) where various program updates and help programs can be downloaded. 
With the registration form supplied (start menu under "MAGIX Photo Manager 10 Deluxe -> Service
and support -> Register") you can register via post or fax. Simply print it out, fill it in, and send it off! 
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Online tutorials
 Interesting tutorials and useful tips for working with MAGIX Photo Manager 10 Deluxe can be found on
the MAGIX website. 
An online connection is required. 
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magix.info
 Help & get help: Directly from within the program, you'll be able to access magix.info, the new
MAGIX Knowledge Base
. You'll find answers to all the most frequently asked questions about MAGIX products and multimedia
in general. Couldn't find an answer to your particular question? No problem ? just ask the question
yourself! 
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MAGIX Screenshare
 This function makes it possible for you to offer assistance to other users directly via the Internet, or to
get help from others. To do this you have to register MAGIX Photo Manager 10 Deluxe first. 
Hint:
 To inform the screensharing guests of exactly what is being shown, it is also a good idea to telephone or
chat simultaneously. 

Register as host for a screen transfer
1.  If you want to start a screenshare instance yourself, then you have to register as a host first. To

do this open the menu "Online" and then select "Screen transfer as host...".
2. In the dialog you can enter a name for the screen session. Your user account name is used here

by default.
3. Now click on "start session". A small window will now open in the bottom right corner which

displays the status of your screen session. A number will also be displayed (session ID) which
serves as a password for your guests. 

4. Start the screenshare instance.

 Register as guest of a screen session
1.  You have to register as a guest to view a screensharing instance. To do this open the menu

"Online" and then select "Screen transfer as guest...".
2. Enter the password you received from your host (8-digit session ID).
3. Now click on "start session". A window will open displaying a smaller version of your host's

screen.
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Reset program settings to default...
 This function is similar to the reset function ? all settings will be reset to default as they were during the
first program start. 
Warning!
 This function erases all adjustments from every program user! Furthermore, all favorites, podcasts
subscriptions, and timer tasks will be deleted. 
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About MAGIX Photo Manager 10 Deluxe
 Displays copyright info and version number of MAGIX Photo Manager 10 Deluxe. 
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MAGIX services in detail
In this chapter
magix.info
MAGIX Online Album
MAGIX Online Print Service
MAGIX Website Maker
MAGIX Blog Service
Catooh – the Online Content Library
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magix.info
 Share your knowledge & get answers
 This MAGIX service offers you and the MAGIX Community at large a central platform for exchanging
knowledge, photos, videos, and music, for discussing and evaluating, for communicating with one
another, for presenting yourself, and networking with other members. 

You will find the sections "Questions & Answers", "Show & Discuss", "Online Training", and "Chat"
where you can play an active or passive role in the MAGIX Community. For this there's not only the 
www.magix.info
 portal, but magix.info directly in your product. 
Ask questions online
 If you have questions or problems with your MAGIX program or you're looking for tips & tricks
concerning multimedia, then you're at the right place. 
Display all questions & answers...
 Use the questions which other community members have asked and the collective knowledge of the
answers to improve your own working methods, to solve problems, and to get to know the details of
MAGIX Photo Manager 10 Deluxe. 
Launch the online training center
 Learn not only theoretically, but also practically what the program is capable of: "learning by doing",
quickly and uncomplicated. 
Let your friends view the contents of your MAGIX.info screen over the Internet on their PCs.
 Ideal for viewing photos and videos together or for receiving support for questions arising during your
creative workflow while using the program (a licensed client will be installed for this purpose). 
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MAGIX Online Album
 In the MAGIX Online Album, you can post your favorite photos online and then send the link to your
friends. All photos are immediately available from anywhere in the world on a professionally-designed
photo website, in well-organized photo galleries, as full-screen slideshows, or in the form of a personal
photo e-card. 

 Personalized photo website in many designs. 
 Unique Internet address (URL).
 Upload your pictures directly from a camera phone, send the link, and share the picture with

other camera phone users.
 Full-screen online slideshows with fade effects and music.
 Send custom designed e-cards with your own photos.
 Share your photos with friends, including Internet management and password access to private

albums.
Your photos online
 MAGIX Online Album is available in three versions, of which the smallest (the FREE album with
500MB webspace for your photos) is entirely free. 
The larger versions (CLASSIC or PREMIUM) are available for a monthly charge, but also come with
many handy features, such as a faster website, 2,000 MB or 5,000 MB storage space, more website
designs or access by mobile phone/PDA. 
More information about prices and included services is available at www.magix-photos.com
. 
Just three easy steps
: Within minutes your first pictures will appear on the Internet: 
1. Select photos
 Choose your favorite photos directly from the program and optimize them in just a few clicks. Put
completed photo albums together and integrate music of your choice. 
Do it all offline on your PC - saves you money! Then select "Services" from the program's menu bar
"MAGIX Online Print Service -> Send selected". 
2. Upload photos
 In order to upload photos to your MAGIX Online Album simply log in using your email address.
Naturally, access is protected via your personal password. 
If you still don't have access, click on Register now!
 to activate your own album in just a few minutes. Then off you go! 
3. Done! Your own personal photo website is finished
 and your best photo memories are on the net. As a photo gallery or fully automatic slideshow
(fullscreen). 
Now, invite all your friends with just one click or show your photos on the road using your
WAP-compatible camera phone. 
Using your MAGIX Online Media Manager, you can quickly manage your photo website, upload
photos and music, create new albums, add designs and text, and much more. All online
 without even having to download any extra software! Worldwide, easy, and quick in just a few clicks.
At http://www.magix-photos.com 
The following options are also available: 
Send e-cards and photo emails
 Send your photos as unique e-cards with great designs, or as a photo email to your friends and
acquaintances. 
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Order photo prints and gifts
 Order paper prints or great photo gifts from your MAGIX Online Album and have them delivered
directly to your home, or pick them up from a photo lab in your area. Delivery time is usually just 2 - 3
days. 
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MAGIX Online Print Service
 MAGIX Online Print Service lets you order paper prints and photo gifts (t-shirts, mugs, etc.) directly
from within MAGIX programs such as MAGIX Photo Manager 10 Deluxe or via www.magix.com.
Upload your photos with a click and have the developed photos delivered to your home within days. 

Order photo prints and gifts
 Order real paper prints or great photo gifts straight from your MAGIX Online Album and have them
delivered directly to your home or pick them up (no shipping costs) from your nearest photo developer. 
Delivery usually takes 2 - 3 days. 
More about MAGIX Online Print Service

  Order your valuable digital photos in impressive quality on premium photo paper from a digital
photo printing specialist 

 Brilliant prints on premium photo paper in all formats
 Impressive picture quality; true-to-color for up to 100 years
 Huge selection of great photo gifts (t-shirts, mugs, calendars, and much more)
 Includes MAGIX Photo Manager for conveniently ordering your photos
 Real prints and great photo gifts of your digital pictures ? it's that easy

1. Select photos
 Take your time and select your favorite photos from the program and optimize them for best results.
Remove redeye, enhance colors and contrast, and much more. All offline and on your PC! 
Then simply select MAGIX Online Print Service from the "Online" menu and "Send selected". 

2. Select format and quantity
 Now select the desired number and the image format (e.g. 10x15) or photo gift (mug, t-shirt). Do you
have a voucher? Then click on "Use voucher" and enter your voucher code. 

3. Specify zoom
 One great option is the crop function for your prints. To use it click on the button "Edit photo". Here you
can set the format (small 2:3 or digital 3:4) you would like for your photos. 
You can see how your photo prints will look in the preview window. Using the selection frame you can
crop your photos individually. 

4. Submit order
 Once you have made all your settings click on the "Submit order" button. Now all you have to do is
enter your details and the type of delivery. Your order will now be dispatched online. 
You will now receive an order confirmation by email including a link where you can find up-to-date
information about your order anytime. 
Delivery straight to your doorstep
 Have your prints and photo gifts conveniently delivered straight to your doorstep or pick them up from a
photo retailer close to you to save postage. Orders usually take 2-3 days. 
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MAGIX Website Maker
 Not only is Internet surfing easy! Thanks to MAGIX Website Maker creating websites also becomes
child's play! 
This service offers:

  Your desired domain (www.desiredname.com) and a subdomain
(http://your-name.magix.net/website).

 250 MB memory space with 5 email accounts, 1 GB each.
 Website Maker with website templates, intros. Also animations, text effects, form and design

objects, picture and graphic templates, and buttons. And everything without any ad banners!
 Photo (*.jpeg), video (*.wmv) & music (*.mp3) options.
 Additional software: MAGIX web mail for managing your email inbox. 

MAGIX Website Maker offers 3 months of free, non-binding service. This way, you have enough time
to find out everything about MAGIX Website Maker and all existing possibilities for editing and
managing your homepage. 
MAGIX Website Maker offers everything for the perfect Flash® website:

  Design templates: Numerous high-quality website templates in the latest professional Flash®

design with pre-finished, customizable subpages, start pages, profile pages, photo pages, video
pages, and much more. 

 Text & text effects: Freely positionable text fields with fantastic fonts and animated text effects
can be added and individually formatted with ease. 

 Multimedia content: Select your favorite photos, spectacular slideshows, videos and an online
video player with your own background music, or integrate it all as an online music player with
playlists.

 Decorative elements: Attractive design objects, plenty of vector shapes, background images,
buttons, and much more offer more possibilities for designing unique websites than ever.

 Animation objects: Large selection of dynamic, impressive animation objects for breathtaking,
moving websites.

 Links: Easily add links to your own or external websites. 
 Top extras: Enhance your website with a visitor counter, guest book, contact form, and many

other useful extras.
Export function
: Conveniently add individual components of your website (e.g. video player, slideshow, online music
player) or even the entire website to external sites as an embedded website. 
Proceed as follows:
 After registering your desired domain, you can start creating your website right away. 

1. First, select a design for your website in MAGIX Website Maker
2. If you would like to place an intro (start animation) at the start of your domain, select your intro

as a next step.
3. Now you can replace the mock text with your own text as you see fit. All free-standing elements

on all webpages can also be moved as you please. To do so, click to select the element and
move it using your mouse.

4. Once everything is just how you want it, you can put your page online, so that your domain can
be accessed. 
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MAGIX Blog Service
 YOU make the news ? Create you own online journal with MAGIX Blog Service! 
Easy to use and lightning fast ? Design your own online journal (blog) however you want: Categories,
keyword for quick searching, calendar, archiving, and much more. No HTML knowledge required! 
Create an account and add up to 5 individual blogs; you decide what your subdomain should be
(http://your-name.magix.net/blog) ? all without any banners.

Spam guard: 
Captchas make the commenting function even more secure against spam and comments which come
from IP addresses or contain links that are listed in different blacklists. 
Manage it:
 MAGIX Blog Service lets you invite authors for your blogs to work together on their growth. Up to 10
authors can work together on a single blog. Every editor can be assigned specific rights: Editor and chief
editor - entries by an editor must be authorized by the chief editor before going live. The chief editor does
not require any authorization! 
Webspace:
 All media that you use in MAGIX Blog Service is managed in the storage space for MAGIX Online
Album. If you still don't have MAGIX Online Album, then you will receive a free album with 500MB
worth of space when you register for the blog service. Upgrade to classic subscription with 2,000 MB,
or you can switch to the premium service with 5,000 MB of memory at any time for a small fee. 
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Catooh – the Online Content Library
 Catooh provides you with high-quality photos, videos, and music for every theme, expanded by
intelligent iContent with professional Soundpools, DVD menu templates, and brilliant MAGIX
ShowMaker styles to help you make your photo, video, and music projects reality. All of this is available
directly from your MAGIX software. 
Just choose "Online" from the menu "Catooh" to set up an Internet connection. 
Browse through the thematically sorted categories or view the results directly by entering a keyword.
After downloading, you can drag the objects from the Media Pool directly into your arrangement. 
Tip: Read the introduction online
! 
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If You Still Have Questions
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Task assistant
 The task assistant is your information center. It helps you complete your tasks and provides support at
every step. Not only will you find clear videos with step-by-step instructions, but you'll also find quick
access to a lot of functions. 
The task assistant chapters can be found in the "Tasks" menu. 

Tips for Program Help
 The program help contains hints on how to use the program and lots of additional information. Many
important terms are indicated in the text in italics and an explanation to them is reached by clicking on
them. 
Context help
: Press the "F1" key at any point in the opened program and help will open with the matching help topic
(context help). 
Search function
: To find out information on specific words, use the search function. Enter either the individual word or
use logical operators (OR, AND, NEAR) to refine your search if you have several search words. 

 "OR" (between two words): All topics which contain both words or one of the words will be
listed.

 "AND" (between two words): Only those topics will be listed which contain both words.
 "NEAR" (between two words): Only those topics will be listed which contain both words. A

maximum of six other words may be added between the search terms.
 "NOT"" (before a word): Topics which contain this word will not be listed.

Print
: Use the help program's print function to make a printout of individual topics or entire sections. For help
cases which may take a long time, this can be more practical than switching between the help window
and the program. The print button is located at the top of the help window in the toolbar. 

PDF manual
 Much like the help feature, the electronic PDF manual contains the entire program documentation. You
can find it under "Start -> Programs -> MAGIX Photo Manager 10 Deluxe" in the "Documentation"
subfolder. 
Note:
 To view the PDF file you will need "Foxit Reader" application; you can find it on the MAGIX Photo
Manager 10 Deluxe installation DVD. 
Tip regarding special program versions:
 This documentation describes the full functionality of MAGIX Photo Manager 10 Deluxe. However, you
may be using a restricted version of MAGIX Photo Manager 10 Deluxe, and full functionality may not be
available. 
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Glossary
 AudioID
 Audio ID is a process used to determine the title and artist name base on musical properties. An Internet
connection is required to access the AudioID database. 

AVI
 The AVI format (Audio Video Interleaved
) isn't actually a proper video format! Rather, it is a so-called "container" for which the conventions for
transferring audio and video files to the program are only loosely defined. More in this topic can be found
in General notes on AVI videos. 

Browser 
A browser (also known as web browser, or Internet browser) is a computer program that displays
websites. The best-known browsers are Internet Explorer, Firefox, Safari, and Opera. 

Button
 Refers to an element of the graphic user interface of a program. The button initiates an action in the
program via left mouse click. 

Button
 Refers to an element of the graphic user interface of a program. The button initiates an action in the
program via left mouse click. 

Cache
 Simply stated, this is a temporary folder where frequently accessed files are saved so that they can be
quickly launched while you are working. 

CC
 CC stands for "Connectivity Co-ordination" and describes how the change of a domain name from one
provider to another occurs (domain transfer). 

CDA
 Short for "audio CD" produced in accordance with the so-called "Red Book" standard. It contains audio
files (music) and can be played in CD-ROM drives as well as in regular CD players in stereos. 

Clip level
 Signifies the volume level at which the recorded signal is overmodulated, or "clipped". 

Clipboard
 The clipboard is used to temporarily store objects during execution of commands like "copy" and "cut". 

Clipboard
 The clipboard is used to temporarily store objects during execution of commands like "copy" and "cut". 

Context menu
 Context menu can be reached by right clicking on a selected object. It offers functions which are
available and can be expected in the given context. 
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Copyright
 Protection of intellectual and creative property against unauthorized copying. 

Copyright
 Protection of intellectual and creative property against unauthorized copying. 

CPU
 Central processing unit
: The name for the main processor of the computer (CPU). Modern computers have even two or more
processors, or one processor with several cores. 

Dialog
 A dialog opens in a new window and lets the user interact with the program. This means that the dialog
can present information to the user and/or expects to receive input from the user. 
A dialog can contain various user elements which can be manipulated by a simple mouse click. Keyboard
entries are also possible. 

Disc project
 A project includes everything that you want to put on your CD and DVD. This normally contains one or
more slideshows and includes a menu structure/menu design which allows you to choose a slidehsow
later on the CD or DVD. 

Disc types
 The disc types determines the format and medium (CD, DVD, Blu-ray disc, etc.) to which the current
project will be burned. 

DNS
 The abbreviation DNS stands for Domain Name Service and refers to a provider of Internet services
that registers domain names for customers. 

Domain
 A domain is the website's Internet address. It consists of the name of the Internet protocol (usually
http://), the computer or network name (such as www), the second-level domain (such as magix), and the
top level domain (like .com, .net). 
Altogether we have: protocol://networkname.second-level-domain.top-level-domain (such as
"http://www.magix.com"). 
Domains are allocated by a country's so-called NIC (Network Information Center). In Germany the
DENIC is responsible for the release of domains. 

Domain transfer
 See CC. If you already have a domain, you can move it from your previous provider to another
provider. 

Drag & drop
 Enables files and objects to be moved freely between various applications (or within an application) by
dragging the object and letting it drop using the mouse cursor. 

Fader
 Used for visual input of values. Similar to volume control on a mixing board, you can control various
parameters by sliding the fader. A very common example for this is the zoom slider that lets you see a
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picture in more detail. 

Field
 A half-image, two of which combine to produce a frame (see interlace). 

Flip menu
 Drop down menus create menus consisting of lists of selectable choices. They look very similar to text
input fields, but have a button with a downward-pointing symbol on the right-hand side. 

Frame
 A frame is a single image from a video sequence which also called a full image. 
A PAL video contains 25 frames per second; NTSC contains 29.97 frames. 

Handles
 Handles are the five little rectangles at the edges of selected objects. All curve points can be moved by
holding down the left mouse button. 
Length handles:
 Bottom right and bottom left. You can use them to change the length of an object. 
Fade handles:
 Top right and top left. These can be used to softly fade an object in or out. 
Volume/Brightness handle:
 Above-center. You can use it to adjust the volume or the brightness. 

Hard disk
 Storage medium with the largest storage capacity where the operating system(s), programs, and files are
saved. A hard disk can be built into the computer, but there are also external hard disks which can be
used with different computers via a USB connection (portable drives or external hard disk). 

Hard disk drive
 Storage medium with the largest storage capacity where the operating system(s), programs, and files are
saved. A hard disk can be built into the computer, but there are also external hard disks which can be
used with different computers via a USB connection (portable drives or external hard disk). 

Hardware
 The all-encompassing name for all internal components of a computer. For example hard disk, graphics
card, mainboard, etc. External peripheral devices are also considered hardware, i.e. printer, scanner,
monitor, etc. The synchronization of single hardware components is coordinated by the software. 

HDD
 Storage medium with the largest storage capacity where the operating system(s), programs, and files are
saved. A hard disk can be built into the computer, but there are also external hard disks which can be
used with different computers via a USB connection (portable drives or external hard disk). 

HDTV
 This acronym stands for "High Definition Telev
ision. 

Hyperlink
 Hyperlinks (or in short "links") are references to other websites/online documents (or other computer
networks). They build the base of the World Wide Web (WWW) as it is only via these hyperlinks that
networking or interlinking between the billions of website out there is actually possible. 
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Hypertext Transfer Protocol
 HTTP stands for "Hypertext Transfer Protocol" and is used for transferring websites onto the Internet
(from web server to the browser). For this reason, the abbreviation http:// always comes before the
Internet address. This is automatically inserted and does not have to be entered when entering the
Internet address. 

ID3 tags
 ID3 tags contain title information that can be added to a music title. This includes the title, artist, album,
as well as the genre, year of release, and other criteria that can help searching through a database. The
database is created using this information. 
Info:
 Title information will only be saved for MP3s in the so-called ID3 tags (Identify an MP3), but other
formats offer similar possibilities, like "Vorbis comment" for the OGG Vorbis format, for example. 

Image
 An image is a representation of a CD, DVD, hard drive, or another storage medium that is saved as a
file. 
The difference from a copy or backup is that an image contains information about the structure of the
original storage medium, and not just individual files. This enables 01:01 copies of complete storage
media to be created. 
Caution! 
Copyright laws forbid copying of commercial CDs/DVDs, and for this reason, this process can be
prohibited by copy protection. 

IMAP
 Stands for Internet Mail Access Protocol and is an advanced procedure used for receiving emails. 

Interlace
 Describes the creation of a full image from 2 half-images (fields). 
In this process, even and odd lines are alternately assigned to one of the two fields. 
The human eye perceives both of the projected half-images as a single full image, so that despite the slow
image repetition rate (25 Hz for PAL, 29.97 for NTSC) a subjectively fluid image is seen. 

Intro
 "Intro" means the introduction or opening credits of a movie. 

jpx
 A format developed by MAGIX which is used for photo editing. It enables free experimentation with
effects without altering the original file. The effects settings are also displayed when the photos are
opened using a different MAGIX program. 

Menu
 Menus contain practically all function of a program. They can be opened using a simple mouse click on
the corresponding menu. Keyboard shortcuts, if available, are also found at the end of menu entries. 
The graphical surface of a CD/DVD will also be represented as a menu. 

Menu bar
 Almost every program has a menu bar. It can normally be found underneath the title line of the program.
A simple mouse click opens a corresponding menu. 
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MIDI
 MIDI files do not contain the actual sounds like audio files, but only the note control information which
can be interpreted during playback by the synthesizer chip on the sound card or an external synthesizer. 

Motherboard
 This is the centerpiece of hardware components of a computer. All other hardware components like
CPU, RAM, hard disk, additional drives, graphics cards, as well as other cards for specialized uses are
connected to the motherboard. 

Motherboard
 This is the centerpiece of hardware components of a computer. All other hardware components like
CPU, RAM, hard disk, additional drives, graphics cards, as well as other cards for specialized uses are
connected to the motherboard. 

Motherboard
 This is the centerpiece of hardware components of a computer. All other hardware components like
CPU, RAM, hard disk, additional drives, graphics cards, as well as other cards for specialized uses are
connected to the motherboard. 

MOV
 MOV is a video and audio format developed by Apple, which has since become widely used with
Windows. QuickTime supports lots of compression technology, which make it possible to optimize audio
and video and even graphics for the Internet and multimedia/video applications. Conventional (hardware)
DVD players are not able to play this format. 

MP3
 MP3 (actually MPEG-1 layer 3) is currently the most important standard for compressing audio files. 

MPEG
 MPEG is short for "Moving Picture Experts Group" and refers to a committee concerned with the
standardization of video and audio data compression as well as container formats. 

MS audio
 A process developed by Microsoft for compressing audio files with properties similar to those of MP3. 

MXV
 This is the MAGIX video format for quicker processing with MAGIX products. It offers very low loss
of quality, but it cannot be played via conventional DVD players. 

Noise Sample
 Sample of a noise that is to be removed 

NTSC (USA, Japan)
 NTSC stands for "National Television Systems C
ommittee". This is a US institution that defined the first color carrier system for TV which is now used in
most of America and some East Asian countries. 
The image repetition rate for NTSC is 29.97 Hz. 

Numeric keypad
 Also known as the numpad, or the number block. 
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OGG VORBIS
 This is a new, royalty-free format with similar properties to MP3. 

PAL (Europe)
 Phase Alternating Line, or PAL
, is a process for color transmission for analog TV that is primarily used in Europe, but also in Australia,
South America, and many African and Asian countries. 
The image repetition rate for PAL is 25 Hz. 

Play marker
 The play marker is a red vertical line which moves from left to right during playback. It indicates the
current play position. 

Playlist
 Arrange your songs in playlists from various sources in different formats and in whatever way you like,
sometimes updated daily. 
Important:
 Playlists are only links to songs on your hard drive or in your CD drive. 
When you add a song to your playlist whose real source is a CD in your computer's drive, the song will
no longer be playable when the CD is removed from the drive. 
Similarly, when you move a folder on your hard drive, the playlist will no longer be able to play the song,
since the link is no longer valid. 
For the latter, however, there is a simple solution: If you know where the song has been saved, then you
can redefine the path. A corresponding dialog window is provided for this purpose. You can reset the
path by navigating through the Explorer folders. The playlist is now correct once again. 

Plug-in
 Plug-ins are additional programs that expand the functionality of the main program. They are inserted
into the main program. 

Podcast
 Think of a podcast as something like a radio station on the Internet. Regular Internet radio stations
"transmit" in real time, which means that you can simply listen to the program that's playing and edit it.
Podcasting is different. The programs are preproduced and loaded to an Internet server for downloading.
As a listener you can subscribe to the podcast and the files will be downloaded at a specified time for
you to listen to them whenever you like, for example on the go via your portable player. 

Podcasting
 Podcast is the name for a relatively new Internet transfer form. It is made up of "pod" from "iPod", the
name of a popular portable MP3 player, and the term "casting
" for broadcasting content to a wide group of listeners/viewers. 
A podcast is therefore something like an online radio station. "Broadcasting" web radio stations means
you can only listen to and record the currently broadcast radio station. Podcasting is different. You as the
listener can subscribe
 to the podcast and the files will be downloaded at a specific time and you can listen to them whenever
you like, for example, on the move with your portable player. The shows are pre-produced and placed
on an Internet server for download. 

POP3
 Stands for Post Office Protocol (version 3) and is used in standard email programs for receiving email
(for example, Outlook Express). POP3 enables email to be collected by the provider's email server and
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loaded into your email program. 

Project
 A project includes everything that you want to put on your CD and DVD. This normally contains one or
more slideshows and includes a menu structure/menu design which allows you to choose a slidehsow
later on the CD or DVD. 

Project
 A "Disc project" includes everything that you want to put on your CD and DVD. 
This normally contains one or more movies and includes a menu structure/menu design which allows you
to choose a movie later on the CD or DVD. 

Provider
 A provider or ISP (Internet Service Provider) offers Internet services like webhosting or domains
(DNS). In relation to the MAGIX Website Service, MAGIX is the provider. 

RAM (Random Access Memory)
 This is a hardware component of a computer. RAM is needed to temporarily save files. This type of
storage is erased when the computer is shut down or reset. The larger this storage is, the faster you can
work with programs to change and save files. 

Ratio:
 The aspect ratio is the ratio between the height and width of a rectangle. In practice these are photos,
screens or projection screens. This method can also be used to describe the aspect ratio of pixels. 
Here are some examples of typical aspect ratios: at home 4:3, 16:9 (typical for TV sets), or 16:10
(widescreen flat screens, widescreen notebooks), 3:2 for 35 mm films and photos. In cinemas you
mostly find 1.85:1

 Red Book
 Specific standards have been established for the different CD types in order to unify their data structure
and to make them compatible with the different CD drives. Their names refer to the color of the books
where these standards were written. 
The term "Red Book" is common language for the Compact Disc Audio Standard. The requirements
listed here have to be observed for industrial CP production. Audio CD players only read CDs created
according to the Red Book format. It is therefore necessary to first convert PC files into this format
before writing them onto an audio disc compatible with any audio CD player. 

Restore
 Restoration of files originating from a backup will be called "Restoring". 

RM
 RealMedia includes all of the media formats from software developer RealNetworks. RealMedia
especially refers to the "RealVideo" video format and the "RealAudio" sound format. The quality of
RealVideo files is comparably good at high compression rates, but does have some loss of quality. These
formats cannot be played back by (hardware) DVD players. 

Screenshot
 A screenshot is an image composed of all visible screen elements (messages, open dialogs, etc.) at a
certain time. By pressing the "Print screen" key on the keyboard, this image is saved into the clipboard.
Next, open a program which can edit images and select "Insert" (shortcut "Ctrl+V") in a new document
to add the screenshot for editing and saving. 
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Note: Press "Alt + Print screen" on the keyboard to capture the active window only. 

Slider
 Used for visual input of values. Similar to volume control on a mixing board, you can control various
parameters by sliding the fader. A very common example for this is the zoom slider that lets you see a
picture in more detail. 

Slideshow
 An arrangement of various objects (photos, text, sound, etc.) is called a slide show. Slideshows can be
saved separately as "MVM" files. 

SMTP
 Stands for Simple Mail Transfer Protocol and enables the exchange of emails across computer
networks. 

Software
 The name for all non-physical functional components of a computer. This primarily includes computer
programs and files that are meant to be used by computer programs. 

Submenu
 Besides normal entries, a menu can contain submenus that offer additional functions. This makes menus
more comprehensive. 

Super Video CD (SVCD)
 The Super Video CD (SVCD) is a technological advancement of the video CD. SVCDs are also like
VCD-specified CD-ROMs which can be played using either a Super Video CD player (connected to
the television), or directly with the CD-ROM drive of a computer. Many DVD players can also play
SVCDs. MPEG-2 and the increase of the data transfer rate makes it hard to tell videos from videos in
DVD quality apart. 
Resolution: 
SVCDs use the better MPEG-2 encoder in a standardized resolution of 480 x 576 (PAL). The
MPEG-2 format offers a maximum resolution of up to 720 x 576 points and improved compression
methods characterized by excellent image definition and homogenity. 
Hard disk capacity:
 An average 90-minute movie must be spread across 3 CDs. On one SVCD you can get about 30
minutes of good-quality movie. 
Encoder setting:
 Compared to the VCD with 1.3, the data transfer rate is doubled to 2.6 Mbit/s. 
MPEG-2 format introduces the so-called variable bit rate (VBR). In contrast to the constant bit rate
(CBR) of the MPEG-1 encoders, this encoder has the option of using more bits for movement-intensive
sections, as well as saving bits if picture content remains the same. 

Toolbar
 Here you will find small buttons that provide a function when clicked. For example, you can cut out a
selected object by clicking on the scissors. 

Toolbar
 All basic functions of the corresponding program can be found here. The corresponding functions can be
called up via mouse click. 

Top-level domain
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 Top-level domains (TLD) are always those separated by a dot at the end of an Internet address (for
example, "http://www.magix.com" < here, .com is the top-level domain). Among these are also country
top-level domains, such as .co.uk, .us, .de as well as so-called generic top-level domains like .net, .org,
.biz, and so on. 

Traffic
 Traffic (data transmission) occurs within your MAGIX Website Service as soon as data is transferred
across the Internet: for example, when uploading or downloading files to your website or when someone
else opens your website. 

Universal Plug & Play; UPnP
 Universal Plug 'n' Play (UPnP) is a network protocol which enables data exchange between different
devices (PCs, hi-fi systems, video cameras, PDAs, and webservers). UPnP allows various devices to
participate in network-wide communication, i.e. the initialization of functions and other device functions.
Long-winded configuring or installing of drivers is not required as the devices can handle their own
functions and data sources by themselves. Find out more at www.upnp.org. 
Hint: 
To work with UPnP you have to activate it first. This can be found under "Options" ("Y" -> UPnP). 

URL
 URL stands for Uniform Resource Locator and describes where a source can be found online (for
example, a website). The address or the path to the storage location of a file on your computer is known
as a URL. Often the term URL is used as a term for the domain. The URL for the MAGIX website is:
http://www.magix.co.uk 

VST and DirectX plug-ins
 Plug-ins are additional programs that expand the functionality of the main program. They are inserted
into the main program. 
Two standards exist for audio editing: VST (Steinberg) and DirectX (Microsoft). VST has asserted itself
stronger in the current market. 

WAV
 Wave (*.WAV) is a standard uncompressed audio format. 

Wave
 Wave (*.WAV) is a standard uncompressed audio format. 

Wave file
 Wave (*.WAV) is a standard uncompressed audio format. 

Webhosting
 This means that an Internet Service Provider makes domains and webspace available to its customers.
With the MAGIX Website Service, MAGIX provides webhosting to its customers. 

Webmail
 Webmail enables the customer to view and receive the contents of their email inbox without having to
install email software on their computer. Customers of the MAGIX Website Service can use MAGIX
Webmail for this. 

Webmaster
 A webmaster is responsible for the administration and maintenance of a website. Often, the webmaster
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is also the owner of the website as well as the domain that belongs to it. Once you have registered a
domain in the MAGIX Website Service, an email account will automatically be set up, for example:
"mailto:webmaster@domainname.co.uk". 

Webserver
 Webserver refers to the computer on which your host saves your website's pages and which makes your
pages accessible on the Internet 24-hours a day. 

WMA
 A process developed by Microsoft for compressing audio files with properties similar to those of MP3. 

WMV
 Windows Media Video (WMV) is a trademark video codec from Microsoft. If you have Windows
installed on your PC, then playing WMV files shouldn't be a problem. Only a few (hardware) DVD
players are able to play this format. Read more about this in your DVD player's manual. 
This video format is very good for web videos as it allows relatively high compression rates. 

World Wide Web (WWW)
 WWW stands for "World Wide Web" and is the most used service of the Internet. On the WWW, web
browsers (for example, Internet Explorer) are used to display information via websites. The process is
colloquially called "Surfing the Internet". 

Zip
 ZIP is a file format for archiving your files. The original file is reduced and then restored to its original size
after it is unpacked without losing any quality. 
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